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In an article in Brazil Magazine (http://www.brazzilmag.com/
index.php?option=com_content&task=view&id=4170&Itemid=49),
there is a description of what I would call Brazil’s
domination plan for Linux. I am thinking this may
be the model the world needs.

The plan is to get hundreds of thousands of 
low-cost Linux systems into the hands of average
citizens. Besides a complete Linux system for no
more than $440, there are low-interest loans avail-
able and special low rates for Internet connectivity.

This is a government-sponsored program. It’s
not a give-away, and it makes good economic
sense. The government end is really just to assure
the systems will meet some minimum requirements
and be financeable.

WHY IS IT GOOD ECONOMIC SENSE?
First, access to computers is just a good thing. 
It increases literacy and also decreases costs of

supplying information. That is, you can provide
access to anything—including government services—
at a lower cost and more quickly with Web access
rather than with phone calls and paper mail. This
is a big plus.

Outside the US, there is another benefit to 
this program; the program is Linux-based. If
someone buys a commercial operating system,
you are basically guaranteed that the commercial
operating system we’re talking about is made 
in the US. That increases costs to the consumer,
and it also puts money into the US economy, 
or at least into the pockets of the US company.

If, on the other hand, you are in Brazil or
Nicaragua or wherever, buying commercial US
software just exports your national currency 
to the US. Looking at this from the perspective 
of someone who lives in Nicaragua, I am sure
that Bill Gates doesn’t need any more money
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from Nicaraguans. Thus, even Bill Gates
should be promoting Linux here if he
has the best interest of Nicaraguans 
at heart.

So, what’s the downside? Well, from
the point of view of nationalism, there
really isn’t any. That is, you get fully
functional computers, and you get 
to keep your software dollars. As this
effort grows, the effect snowballs. 
That is, as the Linux market share
grows, more vendors become interested
in Linux. It gets easier to buy a scanner
that works with your system, and even
easier to get your Internet connection
set up.

See where I am going? This is that
old Linux World Domination angle that
Linus mentioned so many years ago.
The difference is that when I first
thought of it, I lived in the US. Thus, I
figured any world domination attempt
would have to start there. I totally
missed the fact that it was easier and

more economically sound to start 
it elsewhere.

Okay, back to the numbers. They 
are projecting 500,000 Linux (and 
KDE-based) desktops in the first four 
to six months of the program. That, 
in itself, is a significant jump in the
number of Linux desktops. How 
significant is hard to say, because 
you can’t simply count licenses (or
computers sold) to get the number. 
If we go with the Linux Counter’s
(http://counter.li.org) guess of 29 
million systems total, we are talking
close to 2%. That includes servers, 
of which there are many.

More important, this could mean a
close to 2% increase in systems world-
wide with just one country jumping on
the bandwagon. If this were the United
States or one of the bigger European
countries, I would be less surprised. 
But, this is South America.

If we shift our attention to Asia,

China is the other “Linux country” 
that is coming of age. China has devel-
oped its own CPU for running Linux
(Dragon) and its own version of Linux
(Red Flag Linux). A recent press release
(http://www.redflag-linux.com/jujiao/
enews_view.php?id=1000000036)
shows that there is cooperation between
Linux vendors in China, Korea and
Japan. If you could get the number 
of potential users among these three
countries, you will see a huge upside
for Linux.

As the majority of TUX readers are 
in the US, let’s take this back there. 
Are you going to get left behind? Well,
this is where you have a choice. You 
are reading TUX, so you have at least
taken the first step. Although it may 
be a bit harder for you to get on the
Linux World Domination bandwagon
than for someone in Brazil or China, 
it is not that hard should you choose 
to be involved. Linux is happening 
all around the world. Linux is the 
future. I encourage you to participate 
in that future.�

Phil Hughes is Group Publisher for SSC Media Corp.
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Late last year, the Open Source
Development Lab (OSDL) announced 
a new project, Portland, that will be
potentially helpful in creating a mass
market for Linux on the desktop. For
those of you not familiar with OSDL, 
it is a nonprofit organization dedicated
to accelerating the growth and adop-
tion of Linux in the enterprise. It pro-
vides state-of-the-art computing and
test facilities in the United States and
Japan. These facilities are available to
developers around the world. OSDL
also happens to employ Linus Torvalds,
the creator of Linux.

The Portland Project is an initiative of
the OSDL Desktop Linux Working Group
(DTL). The DTL is working toward making
the Linux desktop in the enterprise a
reality by identifying and removing barri-
ers that independent software vendors

(ISVs) face in developing on Linux, speci-
fying the capabilities required of the
Linux desktop and working with the
Open Source community to address
these tasks.

The Portland Project is the result of a
December 2005 meeting of the DTL
architects. This meeting came right after
the release of the results of a survey con-
ducted by OSDL during November 2005.
With more than 3,300 responses, the
survey provided some fresh insight and
resolute confirmation of the top
inhibitors preventing Linux desktop adop-
tion. At the top of the list was improved
application support on Linux. Specifically,
this was the reason the DTL formed the
Portland Project—to develop a common
set of core technical requirements for
Linux and open-source software on the
desktop. The complete results of the sur-

vey are available at http://www.osdl.org/
dtl/DTL_Survey_Report_Nov2005.pdf on
the OSDL Web site.

As we have discussed and debated
here in TUX, there are large groups of
aficionados for both the KDE and
GNOME desktops. If there is a division
seen between fans of these desktops,
there is an equal and perhaps more
inhibiting division between application
developers. The simple problem is that an
ISV must choose between KDE and
GNOME. The libraries necessary to write
applications with KDE and Qt are com-
pletely incompatible with GNOME and
Gtk. Project Portland will attempt to
bridge the divide between these two
software development platforms.

If the DTL can achieve their goal,
many other inhibitors disappear and a
clear path to widespread adoption

P2P
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appears. If ISVs can write applications
that easily run on both KDE and GNOME,
more applications will become available
for Linux. If there are more applications
available with better support, it will elimi-
nate the reluctance of original equipment
manufacturers, such as Dell, to build, ship
and support a PC running Linux and a full
suite of open-source office productivity
software. If it becomes easy to purchase
and receive support for these PCs, the
gates to widespread adoption will be
thrown open.

Portland, named I assume for the city
OSDL calls home, will address other major
issues, including:

� Collaboration within the Linux desktop
community on specifications.

� Providing ISVs and developer resources.

� Coordinating focus on drivers.

� Strengthening the ties between the
desktop and kernel development
communities.

Driver support was another top
inhibitor identified in the DTL survey.
Specifically, some respondents agreed on
the need to simplify the process of

installing and managing peripheral
devices, including USB. This is also a criti-
cal issue for manufacturers of peripherals.
Currently, only a few provide Linux drivers
for their equipment. Unfortunately, they
frequently don’t offer assistance for the
community to create the drivers. I’ll pass
on one suggestion that makes a lot of
sense. When we decide to purchase new
peripherals for our Linux machines, we
should favor manufacturers that ship
Linux drivers. This will help drive the mar-
ket as a whole toward increased support
for desktop Linux.

In conclusion, I wish the DTL much
success in achieving their goal. I know 
I intend on joining the OSDL and volun-
teering to work with them to achieve
this critical task. I additionally want to
acknowledge and recognize the efforts
of everyone associated with OSDL. I
believe that they are focused on critical
work and deserve our support. If you,
your company or your school is using
Linux, joining the OSDL provides valuable
support for the OSDL to continue work
on their mission. For more information,
please visit http://www.osdl.org/about_osdl/
getinvolved_osdl.html/document_view
to learn how to get involved. In addi-
tion, as has been mentioned here at
TUX before, we often forget that much

of the software we love and rely upon
is available for little or no money.
However, this doesn’t mean the proj-
ects and organizations that produce
and support that software do not need
our support. If you are looking for a
nice tax-deductible donation, hey April
isn’t that far off, consider a donation
to one of the many fine projects pro-
ducing the software we use every day.
Two other organizations providing
great support to free and open-source
software are the Free Software
Foundation and the Open Source Initiative.
Please visit https://www.fsf.org/donate or
http://opensource.org/donating.php,
respectively, to help support either of these
organizations and their important work.

With every new collaboration, work-
ing group and project, we are getting
closer to the point of widespread desk-
top Linux adoption. In the meantime,
there is no time like the present to make
your contribution. When it finally does
happen, how exciting will it be to claim
that you were there and helped make 
it happen? I can’t think of any better
New Year’s resolution than committing
ourselves to help build momentum for
desktop Linux.�

Kevin Shockey is Editor in Chief of TUX.
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Doing Things with Linux
I’ve really enjoyed learning about Linux
from TUX. TUX is great! I’m a semi-clueless
newbie. Well, maybe not so clueless—I
have been building my own computers
since 1984, started at the command
prompt in something other than MS-DOS,
the oldest file on my hard disk probably
dates from before you were born and so
on. Also, I have burned and run a couple
of LiveCD versions (Puppy was neat!) and
sort of poked around (not the kind of
“poke” we did back in the Tandy RS days).
So, I am still pretty clueless when it comes
to Linux, but have some understanding
of basic stuff.

However, I want to do things. The things I
want to do are:

1. Create a Linux-based server to provide
a local (parallel port or USB) printer
(HPLaserjet 4) to a LAN with different
OSes (Linux, Windows and Mac).

2. Have a server provide encrypted 
storage for backups from LAN with
different OSes (Linux, Windows and
Mac boxes).

3. Have the server also manage traffic to
and from the Internet, inspect packets
and handle routing on LAN with different

OSes (Linux, Windows and Mac).

4. Have a LiveCD with the capability to
search and quarantine malicious files
for all types of OSes (including Win
and Mac).

I researched item 4, and it doesn’t look
possible today, because Windows filesys-
tem are still a hurdle, and there is no
antivirus/antispyware that combines all OS
signatures in a single dat.

Item 3 would be of great value, especially
if the client machine process has to iden-
tify itself and be on a whitelist already at
the server in order to send anything
through the server and out onto the
Internet. It could even be strengthened
with keys entered manually by an admin
at setup.

Item 2 would be even neater if there
were a common interface multiple OS
backup/encrypt program.

Item 1 means that a Linux-based printer
management program has to accept
what the various OSes can offer and
make it happen—while maintaining
sufficient communication with the
client machine so that it is satisfied
that “printing” happens.

Is there any really good advice as to how
someone might go about learning what is
possible? Who are the experts and where
are they? Will they respond to queries of
this type, or should I “buy the book”?

PS: I may have asked a question that
inspires a new product. Any rights inuring
to me are hereby released to the general
public—have at it guys!—and if it can kill
an IP patent, even better (with a one-click
here and a one-click there, old
MacDonald had a farm...).
--
TV

You may want to try Linux Journal for
help doing some of these things.—Ed.

TUX Appreciation from Serbia
I am writing you from Serbia where Linux
is the OS that builds its way to users and
slowly becomes the major OS on most
home PCs. I am not a new Linux user, but
I love to read your magazine for fun—you
give great descriptions and news from the
GNU world in a very interesting way.
What can I say? You are great.

Now, here are some things you could do
to get even better. Why don’t you write
some articles about using Blender,
PovModeler or some video editing soft-

LETTERS
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ware? I believe that I am not the only one
who uses these types of programs on
Linux. It would be interesting to show
that you can do these operations on
Linux, as on Windows, because migrating
programs from Win2Lin is major problem
for most users who start using Linux.

I often get questions like: “Do I have
something like SoundForge in Linux?”
or “Do I have Photoshop in Linux?”
People don’t know about most programs
that do the same thing even better,
although they are dual-boot users. It
would be good for them to know about
some things like that.
--
Ivica

Thanks for the kind words, and thanks
for the article suggestions. I agree. I
bet there are many people potentially
interested in those topics. Now comes
the hard part, finding someone to
write them up for us.—Ed.

TUX Appreciation
I had started reading your on-line 
magazine since the first issue, and I
would like to say THANK YOU for the
great magazine.
--
A Linux User

A Print Version of TUX?
I have been playing with Mandrake since
version 9. I’ve kept current, re-installing
each newer version as it became available. I
even considered joining the Mandrake Club.

As of this date, I am still playing. The rea-
son is that there just doesn’t seem to be
any source devoted entirely to real newbies
or beginners. I have a box entirely devoted
to Mandriva, but my daily excursions have
been with another box devoted to
Windows 2000.

What little I know about computers and
operating systems has been gleaned from
the Net itself and most important, a mag-
azine known as PC Novice, which has
become PC Computing. I continue to sub-
scribe after all these years.

The reason I am relating this is that I
would love to give TUX a try as a hard
copy. Your offer of an on-line subscription
is most generous, but I (and a multitude
like me who live in rural areas) have
deplorable phone service. My best con-
nection has a download rate of 2.9 kbs.
Yes, that’s right, two point nine.

Downloading anything takes forever. Most
of my updates and downloads take place at
night. I merely start the download and then
go to bed. If I am lucky, the phone connec-

tion won’t disconnect during the night and
my file will be available in the morning.

This is a roundabout way of saying that if
you come out with a hard edition of TUX,
I will gladly subscribe.
--
Owen Berio

SAMBA Basics Already Covered
Having read TUX since issue 1, there’s one
thing that I’ve continued to fight with,
and I wondered about the possibility of
an article explaining the basics of Samba.
I’d have thought that Samba is the sort of
thing that new users might want to try.
Plus, although there seems to be an
absolute deluge of info out there, so
much of it is given in a confusing and
over-complicated way.

I would like an explanation on doing a basic
network of, say, one Linux system, one
Windows system and one printer. Surely
that’s the sort of setup you might expect to
find in an average new user’s home.

I know that I’d certainly benefit from such
an article, and I suspect that a number of
other readers would as well. Keep up the
good work.
--
John Davis

P2P
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Samba has already been covered in the
August 2005 issue: “Dancing with
Windows”.—Ed.

Praise for TUX and John Knight
I would like to thank you for this 
wonderful magazine. I have been a
GNU/Linux user for the past four years.
I started using it at the age of 15. I
especially love John Knight’s “The
World beyond KDE and GNOME” series
[see the September, November and
December 2005 issues for John Knight’s
articles on lightweight desktops]. I 
hope you review AfterStep. I am still
not shifted over to Linux fully, because 
I can’t get my internal modem working.
It’s a PCTEL HSP56 modem. I use
Ubuntu 5.10 (Breezy Badger).Thank 
you for this wonderful magazine.
--
Vignesh

A Big Thank You for TUX
I just wanted to write a note of encour-
agement to the staff and supporters of
TUX magazine.

After recently receiving a threatening let-
ter from SBT, our organization has been
seriously looking into open software. We
are migrating to OpenOffice.org and are

encouraging our employees to consider
Firefox and Thunderbird—but we had no
intention of moving away from Windows.
Windows is so easy, and Linux is for
advanced computer users, right?

I was at the airport the other day, and I
saw a magazine about Linux. I picked it
up and flipped through—it may as well
have been written in Chinese. See?
Linux is for serious computer heads
only. Then I ran across an ad for TUX
magazine: “The first and only magazine
for the new Linux user”. I looked you
up the very next day and began reading
from issue 1.

I got so excited. Linux was beginning
to look absolutely doable. Not only is it
more cost effective, but it is also more
powerful and not so difficult to use
after all—if you have the right maga-
zine to help you through the transition.
I took your magazine and my enthusi-
asm to our system administrator.

Today, I’m installing Linux for the first time. If
all goes well (and I expect it to), our organi-
zation may begin the move away from
Microsoft some time in the near future.

A big thank you to our friends at SBT and

TUX magazine for showing us that we
have so many options.
--
Jeanne-Marie

Be sure to let us know how your installation
went, and I’m glad we could help.—Ed.

RE: Letters—A Love Affair
with Linspire and Breakup
with OpenOffice.org
Another helpful hint to speed up
OpenOffice.org startup, along with the
Quickstarter, is as follows [see December
2005 Letters]:

Start Writer and select Tools→Options. From
the first branch of options (OpenOffice.org)
select Memory. Set the Graphics Cache Use
for OpenOffice.org to 32MB (default is
9MB). Select OK. Closer Writer. Close the
Quickstarter. Restart Writer, and you should
notice a quicker startup.

And now for an unrelated request for an
article, could you please run something
on podcatching tools? Under Windows, I
have used ipodder lemon and FireAnt,
much preferring FireAnt, but it is unfortu-
nately not available for Linux.
--
David

P2P
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In Defense of Mango Parfait
Hmmmm...does she need defending? I
must admit, reading some of her com-
ments is a bit like watching those
shows that people go on to tell huge
audiences about the secrets their hus-
bands/wives don’t know about—like
not being able to tear your eyes away
from a train crash, I just can’t not read
it. Then, when I think, “I’d never write
to her”, I wonder if I would, just to see
what she’d say to me.

I sometimes find her comments con-
fronting (a polite way of saying somewhat
rude), but others are very funny. My only
conclusion is that if you want to read a
cool, clear, unemotive technical explana-
tion, she’s not your girl.

If you want a clear, technical explanation
with chili and a very idiosyncratic presen-
tation, then okay. Like Tigger without his
bounce (for those in the know), he’s just
not Tigger.

My only hope is that people, both new
and not so new to Linux, will not be put
off, but rather will enjoy how she
writes—see it as adding some serious
colour to their reading and gain lots of
useful information in the bargain.

Overall, I’d say, “Keep it up, Mango.”
I look forward to being confronted and
entertained each month.
--
Patrick Elliott-Brennan

Possible Problem with Klik
and Firefox
Okay, I’m biased. I once wrote to Jes
Hall before she was famous, and I 
avidly read her articles. Unfortunately, 
I experienced a problem that I think
others should be aware of (though it is
not necessarily the case that everyone
will have the same problem).

I downloaded Firefox 1.5 using Klik [see
Jes Hall’s article “Klik and Run” in the
December 2005 issue]. Other apps have
worked well, but Firefox borked my desk-
top install, and I had to uninstall and re-
install it to get it back to working order.
I’ve posted to Klik, and another poster
has asked for people to comment if
they’ve have similar problems with this
particular application.

In short, if it gives an error regarding
“chrome”, do not select okay!

Please see http://www.knoppix.net/
forum/viewtopic.php?t=22350.

That said, gcompris (for my children)
works brilliantly.
--
Patrick Elliott-Brennan

Kudos for Evince
I skimmed over your review of Evince
[see the November 2005 issue],
referred to as Document Viewer in
Breezy, and I was shocked to discover
that although it doesn’t render your
fine magazine as well as Adobe’s
Reader, it does remember where I left
off! I was so shocked to discover this
that I had to double-check to make
sure Adobe’s didn’t. This is just too
awesome! Big kudos to Martin and the
guys for such a nice program.
--
Alan

Praise and Thanks
I’ve just finished reading your newest
TUX PDF. Great magazine. Very pol-
ished and professional. Thank you for
the kind words about KDE throughout
the magazine. With the recent 3.5
release and all of the associated effort,
I’m sure the developers enjoyed all of
the coverage.
--
Wade Olson
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Re: A Brief Affair with Xandros,
a Reader Responds
In the December 2005 issue of TUX, a
reader asks for an alternative to
TurboTax on Linux. I have been using
TaxACT for the past four years. I con-
verted to Linux more than a year ago
(before tax time last year), and I used
TaxACT last year even though I was on
Linux. They have a Web version of their
service that will allow you either to file
on-line or file a paper return (you even
can save a PDF version of your return
for your records). I think the best thing
about TaxACT on-line is that you can
start your filing at home, add to it from
work and even finish and file from a
different location/computer.
--
Jason Dion

Re: A Brief Affair with Xandros,
TurboTax on Linux
I’ve been reading your magazine since
the first issue, and I think it is only get-
ting better. TUX and Linux Format are
the only Linux magazines I have contin-
ued to read on a regular basis. In the
December 2005 issue, I notice you have
a letter from a gentleman who says
that he will happily divorce Microsoft if
he can figure out a way to do his taxes
on a Linux computer, and says that he

uses TurboTax for all of his taxes.
Because you did not answer that objec-
tion, I feel I should. Great news for all!
If you visit http://www.turbotax.com,
you will find that you can use TurboTax
on-line without downloading anything,
regardless of the OS you use. I have
used it for the last three years and find
it to work wonderfully. The only thing
you will miss out on is the ability to
import your tax information directly
from Quicken; however, if you use
GnuCash you can export its files as .qif
files. That might allow you to import
the information into TurboTax, but I
have never tried it, so I can’t vouch for
it working. Keep up the great work!
--
Bryan E. Parks

An Issue with Sony PSP
Compatibility
First of all, let me say that I have been read-
ing your magazine for about six months
now, and it’s great. It’s at least as good as
Linux Format although not as in-depth.

I just wondered if you would consider
doing an article on problems using gadgets
with Linux, such as the Sony PSP. I am
using Debian Sarge, and although I can
access files on the PSP memory stick via the
PSP USB cable and write to it, the PSP does

not seem to recognise them as being
present. This is not the first time I have had
this problem using Linux, and it is frustrat-
ing as I long to rid myself of Windows on
all my PCs. It’s these unexplained incompat-
ibilities that often put new users off, and
maybe some publicity would stop them
from happening in the future.
--
Reginald Norris

Do We Need a TUX Index?
I have been reading TUX since the first
issue, and as a newcomer to Linux, I find
it very interesting and informative.

However, I now have nine issues, and
hopefully there are many more to come.
Therein lies the problem. I am finding it
increasingly difficult to locate/look up arti-
cles. I anticipate that this will become a
major headache as time goes by and the
number of issues continues to increase.

Would it be possible to make available
an overall index that would encompass
all issues already published? If this
could be updated each month and
made available alongside the monthly
issue, I feel it would be a great help for
back-referencing for us all.
--
N.McG.
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I know someone that would really
appreciate a fully indexed database of
TUX issues. Me! Please drop me a line
if you also think this would be useful at
ed@tuxmagazine.com.—Ed.

The Bane and Blessing of Linux
In response to Bill Rowland’s question
in the December 2005 issue (“A Brief
Affair with Xandros”): Bill asked how
the Linux community does taxes with-
out something like TurboTax. You can
do your federal and state taxes on-line
and efile at http://www.taxact.com.

I just started subscribing to your maga-
zine and really enjoy it. I just want to
comment on the Linux distro wars. As a
fairly newbie, I think the multiplicity of
distros is both the bane and the blessing
of Linux.

On the one hand, almost everybody
should be able to find a distro that
suits their needs. I am currently using
Kanotix because that was the only one
I could find at the time that would find
all of the hardware I had in my
machine. So, if there had been only
one flavor of Linux available, it would
have required me to customize and
recompile the kernel and do all 

the tweaking necessary to support 
my hardware.

On the other hand, it makes it harder
for folks who are not gurus to collabo-
rate. I might be somewhat familiar with
where Kanotix (Debian) expects things
to be, but I would have a hard time
helping a friend who is using something
else, like Red Hat. I’m just grateful for
resources like you that can help me get
up to speed.
--
Dave

Reading TUX Magazine on My
Nokia 6680 Smartphone
Let me congratulate you for your fine
magazine. I have learned a lot from it—
thank you!

I travel a lot for my work, without a lap-
top, so I would like to make use of my
Nokia 6680 Smartphone’s ability to dis-
play PDF files to read your fine magazine
on the road.

The problem is the Nokia is capable of
loading files up to 1MB in size, and it’s
limited memory capacity prevents it
from loading the whole file to memory.

I would like to be able to convert the
files, somehow, so they will load a page
at a time and be optimized for 177x208
pixel display. Can you help me?
--
Amichai Rotman

Love the TUX magazine!
I have extremely sore wrists at present,
and one diagnosis is that it is due to lots
of keyboard work. It has therefore been
suggested that I use some speech recog-
nition software to help me. And, of
course, everyone starts making sugges-
tions that are Windows-based.

But I use Linux; I want to use Linux; I love
using Linux; I am more productive using
Linux. Well, at least I was more produc-
tive. But if I am forced to adopt
Windows-based voice-recognition soft-
ware...well, I’d rather not go there! Could
you please do me a great service, and
review some Linux speech recognition
software?
--
P.

With a little research I have confirmed
that most speech recognition information
on the Web is a little outdated. This def-
initely is an area that deserves attention.
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I believe that most of us could benefit
from learning more about accessibility
tools for Linux. In fact, the unavailability of
accessibility tools within OpenOffice.org
helped the opponents to object to the
OpenDocument implementation within
the State of Massachusetts.—Ed.

Mandrivia for Mobile Wireless
Ease
I’ve been an avid reader of your maga-
zine since the second issue and always
have been impressed with the friendli-
ness of your magazine to new users. I
was very surprised to see your article
on ndiswrappers and wireless network-
ing in the August 2005 issue of TUX. 
I read in fascination as you took us
through each step of the process. But
for laptop users, there is a much easier
way. May I suggest Madrivia 2006 
free edition?

Mandrivia claims to be the only Linux
distro for laptops, and I have found it
to be completely true. I’ve tried Fedora
Core, SUSE, Ubuntu, Debian, Xandros,
Linspire and a few others, but only
Mandrivia found all my hardware, con-
figured it correctly and—here’s the
good part—ran ndiswrapper as part of
the installation. I was blown away with

the ease of installing my Broadcom
BCN94306 wireless card in Mandrivia. I
simply chose to use a Windows driver
and browsed to where my .ini file was
on my hard drive. Mandrivia took care
of the rest and ran me through the
connection wizard.

I’ve been trying to find “my” Linux dis-
tro for nearly a year now. I’ve finally
found it with Mandrivia. It is easy to
install, easy to set up, and it found all
my hardware with very little effort from
me. All I needed to know was the name
of my device and I was up and running.

I cannot recommend Mandrivia enough
for laptop users who are having wireless
connection problems. I can finally use my
HP laptop the way it was meant to be—
free and wireless.
--
J. Hudson

Vector Linux Appreciation
If people have an old machine and do
not have the money to get a new one,
they may want to give a try to a light
distro. You also may like to review Vector
Linux (http://www.vectorlinux.com). 
I installed it on my PC, and with less
than 1GB, I now am able to hear all my

music and watch my DVDs and use
OpenOffice.org. So, I encourage you
good people at TUX magazine to do 
a review.
--
Minor Morales A

Nokia 770
Now that the Nokia 770, an almost main-
stream Linux product, has been launched,
perhaps you could do a short (or longer)
review on it. It certainly seems to have
huge potential to open up completely
new markets. It has changed my Web
browsing habits considerably. It is certain-
ly not without its flaws, which is exactly
why it would make an interesting topic
for you to cover. See where it’s good and
where it’s lacking. What works as adver-
tised and what doesn’t.
--
Urho Konttori

I’m pretty excited about the Nokia 770
too, so look forward to a review in the
March 2006 issue.—Ed.�
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We received a lot of great responses to
Nicholas Petreley’s question to readers in his
“What Will You Pay For?” column in the
December 2005 issue of TUX. I decided that
the responses deserved recognition, so we are
including as many of them as possible. Often
the explanations behind the responses were
lengthy and off-topic, so we’ve trimmed the
responses down to the key points.

As you might expect, the responses repre-
sent a good cross section of opinions and prod-
ucts. Some of the responses were popular and
previously addressed in the Letters section of
TUX. In summary, it was very common that peo-
ple would pay for:

� Linux distributions.

� Linux-specific games.

� Utilities that help Linux run applications or
games built for Microsoft Windows, such
as CrossOver Office, VMware and Cedega.

� Special-purpose applications, such as com-

puter-aided design, genealogy, optical
character recognition or tax completion.

A few responses indicated that they
would pay for office productivity software,
such as EIOffice or TextMaker, but in general,
most are content to use existing “free” office
productivity software.

Although many responders indicated that
they would not buy software, they have or
would consider donating to projects. As I
have urged in my From the Editor column in
this issue, I hope more people using free and
open-source software will donate to proj-
ects. My gut tells me that far more people
say they will donate than actually do. I
know, because I’m embarrassed to confess, I
donate less frequently than I should. On the
other hand, sometimes we overvalue mone-
tary donations and undervalue donations of
time, support and effort. I’m also guilty of
this. Since discovering free and open-source
software, I’ve donated a lot of time writing,
speaking and promoting free and open-
source software. For me, the question I have
to answer is “Have I donated enough to
ensure that the projects or companies that
create the software I use, and the ecosystem
that sustains them, survive and able to con-
tinue to do what they do?”

Without further delay, I would like to share
some of the answers to the questions: “Would
you actually pay for superior Linux software
even if an equivalent ’good enough’ program
was available for free? If so, what would you
put on your list of software products that you
are willing to buy?”

TThhee  $$6644  QQuueessttiioonn
In the December 2005 issue, TUX asked readers
to respond to important questions on the Linux
desktop. This special section compiles the
responses and ponders the potential cost and
value of Linux software.

KEVIN SHOCKEY

Would I pay? Man, that is a tough question.
Being so accustomed to getting everything I
need for free, plus being so stable, I just don’t
know. If the software is far superior, runs on
Linux and costs $$$, I would definitely consid-
er it over using a Windows platform/applica-
tion. What is my final answer you ask? YES, I
would.—Matt

I personally keep my windoze partition
intact on the off chance that I want to run
KOTOR 2 or Guild Wars, but I spend about
99% of my time in Debian (I know, it’s
weird to run Debian as a desktop, but I
love the power).

I would pay money for native versions
of games for Linux. I would perhaps pay
more for Linux-only versions of games—
$20 for a port and $45 for an exclusive
would be about right.—Aaron Duty

I too wanted my Linux OS for free. When I
saw a couple of months ago that Linspire
was giving away copies of its Five-O desk-
top, I signed up and got a copy, and planned
on reconfiguring it to use apt-get (instead of
the pay-for service Click & Run). Instead, I
was so impressed with the ease of use of
Linspire that I did something I never thought
I’d do: I paid for Linux. Yes, I have actually
coughed up $35 over the past two months
and gotten the CNR Gold subscription
plan.—Kris

http://www.tuxmagazine.com
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Yes, to paying for a distro. I routinely buy each release of SUSE and would continue
to do so (either SUSE or some other distro) provided the price point is in the
$50–$100 range and the media includes a paper manual.

Yes, to paying for quality Linux applications. I am more than willing to pay for a
Linux application provided it meets my specific needs, isn’t already available free
elsewhere and is of comparable quality to commercial software for the Win platform.
Some examples would be a TurboTax for Linux, a CAD program able to handle auto-
cad files and a 100% feature-compatible Excel.—Scott Leighton

Up until this point, I hadn’t paid for
any software that I had, and most of it
was pirated. My life was changed when
I started using Red Hat Linux 6.2. I
found Linux to be an amazing operat-
ing system and have since moved my
server(s) and workstation(s) to Linux,
and have removed all traces of
Windows. All my software is now either
GNU GPL, open source or free (in cost).
One thing has changed, however; I now
donate to any project that I use and
find worthwhile. I am actually “paying”
out a lot more money than I was
before, but because I want to, not
because I’m forced!

In short, I would pay for non-free
software, but it would clearly have to
be a fair bit better. I would probably
sooner donate $100 to a project such
as QEmu (a GPL PC emulator) than buy
VMware. I am not against people
charging, but I guess I’m more inclined
to encourage truly free (as in speech)
software.—Todd

I have already paid for SUSE 6.0, 7.1 and
9.1. I purchased 9.1 after downloading
9.0. I loved SUSE 9. Every piece of hard-
ware I had at the time worked perfectly,
and I was so impressed that I went out
and bought the PRO version of 9.1. This
unfortunately was a mistake. They no
longer supported my Intel 815 video chip
for installs, and suddenly I have this
blocky problem while in KDE (parts of
the window are not fully drawn, and it
looks horrid), which interestingly enough
doesn’t show up under GNOME.

I would pay for shared libraries that
provide non-Linux functionality, such as
a legal version of libdvdcss, a similar
library to access iTunes and a bundle of
codec libraries so I can view WMA and
Quicktime files. I don’t want full-blown
programs. There are enough applications
for Linux, and we don’t need the bloat-
ware crap that others add. I just want
the low-level interfaces to work with
Totem/MPlayer/XMMS/Rhythmbox.
—Alan

Your question is one of those
“wrong” questions. As soon as 
software/information has a price,
its value is greatly diminished.
No, I have not misunderstood the
terms. You see, if it is free, I can 
hand it on freely. I can contribute to
it, knowing my small contribution
will be free to all others. I know 
that all small contributions of others
will result in vast benefits to me.
As soon as so much as a peppercorn
is charged for information its value
is greatly diminished.

So what will I pay for? I won’t.
Not a single cent—as a matter of
principle. However, I have a growing
realization of the value of this free
information. It is of great value 
to me and great value in creating 
the sort of society I wish to live in.
If I go to the shopping mall and
spend money, I’m pushing a largish
lever that says “More Shopping
Malls”. And lo and behold, another
dirty great shopping mall blights 
the landscape.

So now I’m going around looking
for a levers that say things like
“More Libraries. More Free Software.
More Free Ezines. More Creative
Commons Content”. And I want to
push on these levers.—John Carter

http://www.tuxmagazine.com
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I would flat out be willing to pay for Cedega for Linux. I’m sure I could get Wine to
do what Cedega does, but that will involve work defeating the whole purpose of the
fun. I’m just a student with a low-end laptop, so it wouldn’t matter till I get a job. My
only issue is getting game developers to care. A few games isn’t nearly enough. Aside
from id and Epic Games, I can’t think of any major developers that put out games for
Linux. And will having a software package like Cedega discourage developers from
developing Linux-native engines, if they see that Linux people are getting it to work
in another way? I’m currently a content Ubuntu user, but honestly native Linux game
support is practically non-existent. What can we do turn this around?—Christopher

I’ve seen letters from people who are
looking for alternatives to Quicken.
Quicken was the only program I
needed from the MS world. At first I
(bought) and used VMware just so I
could use Quicken. It worked well,
but I cringed every time I had to
bring up XP just to run one program.
Then I discovered CrossOver Office
v5.0. Now I can have my Quicken and
dump the MS virus for good. Well
worth the $39.95.—Steven Ahlstrom

I operate a rudimentary home-office
network. Being self employed, any time
I spend on sysadmin-type activities
takes me away from paying work. I will
pay $500 for a Linux system in which I
do not have to configure a single piece
of hardware and which will remain cur-
rent for two to three years. At the rate I
bill my time, if I spend more than a
couple of hours installing and configur-
ing a system, it starts looking real
expensive.—Andy Carter

I will surely buy CrossOver Office 
or VMware. And that’s just for 
running an electronic simulation 
program for which I can not find 
a replacement. So, I have to go to
my university to run it.

But here in Argentina, there’s 
one big factor that would prevent
me from doing it: one dollar is three
of our Pesos, which roughly means
that my pocket well feel a $60 US
order as an $180 US one. And the
effort to get 1 dollar is equal to 
getting 1 Peso (let’s say we are 
even in that).

You may think this is a wonderful
scenario for promoting FOS, but it
happens to be quite the contrary.
The situation has caused only one
thing, pirating. And that’s a more 
difficult thing to eradicate. A copy 
of Linux has the same value (if 
not more) than a copy of any 
proprietary software. “Why 
switch to Linux if I can get all 
the software I want for almost 
nothing” is one of the most 
common phrases you will hear 
when attempting to show FOS’s
virtues.—Lisandro

First off, being a student, I can hardly afford to buy software, and as such, open/limit-
ed-version distros suit me best (I use openSUSE 10). As soon as I start earning a
decent salary, however, I will most definitely hit the donate buttons of several of the
programs that I use day to day to show my support. But, unless there’s proof beyond
doubt that the software I’m buying will give me 101% of all the features advertised,
with minimal tweaking on my part, I will not buy it and rather I’ll stick to the “good
enough” versions.—George

http://www.tuxmagazine.com
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In conclusion, depending upon your culture, your politics, your econ-
omy or your beliefs, the concept of paying for something that is
“free” can be one of the most confusing and divisive issues associat-
ed with free and open-source software. For some, this isn’t even an
issue, and the logic behind their positions is extremely clear—to
them. It is challenging not to monetize things when most of us live
in societies that are driven by money. For me, the root of this confu-
sion appears to be due to our tendency to attribute a cost and place
a value on everything. This situation is complicated further when we

over-dramatize the “success” of the software industry as we know
it. As one of the replies stated, maybe these are the wrong ques-
tions to be asking in the first place. What is most important to me
is that we do whatever it takes for us to continue to have choices
when it comes to the software we run on our computers. If that
solution entails buying, let me get my credit card and start shop-
ping. If the solution requires donating, I’ll continue to give my
money, time and creativity to ensure we still have a choice.�

Kevin Shockey is Editor in Chief of TUX.

I would pay for Tax Software that runs
natively on Linux!—Howard

TextMaker word processor (http://www.softmaker.de)—$49 regular price. It beats the
pants off OpenOffice.org in speed and produces acceptable output in M$ Word format.

Mandriva Linux 2006, seven-CD set from Linux Central (http://www.linuxcentral.com)—
about $20 including shipping. Includes the NVIDIA video drivers I need, which (I think)
aren’t included in the Mandriva download edition.—David McClamrock

Using the recommendation of my nephew, who took sympathy on me, I purchased SUSE Pro
Version 8.2. I later purchased the standard version of 9.0 and 9.2. After using those for a
while, and staying confused most of the time because of lack of support and money spent
with little return, I turned to Fedora (at that time FC3). I learned a lot through groups, and
what I perceive is greater consistency in operations. I am now using FC4.

Although the majority of my software is downloaded, I have purchased Win4Lin, and I did
buy Xandros 3.0. I’m still with FC4. I try to purchase software when possible, because I
believe the developers should be rewarded.

As I said, I do believe software should be purchased, and I appreciate the free concept to
allow me to use and try and make decisions. This is superior to the Shareware of Windows
and what I term advertiseware of Windows.—Harry DeLong

I’d pay for Ubuntu (or maybe Kubuntu) with
support. For some reason, I like them bet-
ter than others I’ve tried. I guess I’m odd,
because I seem to relate to GNOME better
than KDE—I’ve found it easier to config-
ure. I’d pay for support because I’m in need
of some installing-and-getting-it-running-
right help. I’m shy about asking, once more,
for help in the forums, even though I find
hints in the archives quite often.

I’d pay for a good CAD system,
something like CADKEY, that is, if my
consulting required it.

I’d pay for Ancestor Quest genealogy
software. I find GRAMPS sourcing awk-
ward. If LDS would port PAF 5 to Linux,
they’d have a big-time winner.—Dave

I would pay for good games for Linux. My only reason for keeping Windows around is
for games such as Diablo2, Doom3, Microsoft Flight Sim (I also run Xplane, which does
exist for Linux) and the Rollercoaster Tycoon series.

I currently run Xplane and America’s Army only on Windows, as that is set up for
games. I plan on building another system next year as a dedicated Linux box (currently, I
dual-boot) and at that point I will seriously consider purchasing a license for Xplane for
Linux and well as running the Linux version of America’s Army.—John Bucsek

If there were a really good optical 
character recognition (OCR) program for
Linux in the $100 price range, I would
probably buy it.—David McClamrock

http://www.softmaker.de
http://www.linuxcentral.com
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Hello, it is me again. I hope you had great holidays. I had
great holidays. I got almost everything I wanted for
Christmas. I am still waiting for someone to buy me one of
the Virgin islands. My friend Bunny says she does not want a
Virgin island unless it has armadillos. Do the Virgin islands
have armadillos on them? I do not know. I hear they have
little bugs I do not know how to spell. They are called some-
thing like no-see-ums because you do not see them but they
bite you. If this is true, maybe I should ask for a Pacific
island instead of a Virgin island. I do not know if I want to
own an island with invisible bugs that bite.

I make many New Year’s resolutions for 2006. My first
resolution is to be more humble. I am going to be so humble
everyone will be very impressed by how humble I am. People
will walk by and say, “Look at Mango. She is such a genius, so
beautiful and yet this has not made her head big. She is the
most humble, beautiful genius I know.” Bunny says I should be
proud of myself if I can live up to this resolution. Why does
she say “if”? Of course I can do this resolution. I am good at
everything I do. You wait and see. I will be the best humble
person who ever lived.

I enjoyed your questions. Keep sending me more good
questions like these.

Q I have tried several Linux distros, but I think I have
found my home with Ubuntu.

There is just one thing I am disappointed with when using
Ubuntu. I am not able to get permission to write to my floppy
media, which has root permission. I can get permission for
/dev, but not for /fd0. I have posted on three different forums,
and the only replies I received were people that were having
the same problems as myself. I am wondering what all the
secrecy of writing to a floppy in Ubuntu is about? Can writing
to a floppy media in Ubuntu be done?—Sarah

A Hi Sarah. I like your name. One of my best friends is
named Sarah. She tried to steal my boyfriend Otaku from

me, but she couldn’t make him like her more than me. I forgive
her. She’s still one of my best friends.

I cannot write to the floppy in Ubuntu Breezy Badger either if
I use GNOME Nautilus. I cannot even make Nautilus mount the
floppy drive. Here is something crazy. Nautilus says that the flop-
py device /dev/fd0 belongs to the root user and root group. This
is not true. If you know how to look at the owner of the device
/dev/fd0, you will see that it belongs to the root user and a
group called floppy. GNOME people tell me the GNOME philos-
ophy is to make a desktop that “just works”. Maybe they need
to change the motto to “it just barely works”, because it does
not work with the floppy drive in Ubuntu 5.10.

At first I look for the problem. Then I give up. I ask Otaku

Replace the tubes in your floppy-based computers, fix up Mepis and repair your (cough) innocent Usenet downloads.
MANGO PARFAIT

Q&A with Mango Parfait
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what he thinks. He says if you are still using a floppy drive, then
maybe you need to replace one of the vacuum tubes in your
computer. I do not understand this answer, so I go back and
look for another answer.

Like I say before, the /dev/fd0 device belongs to the
group called floppy. Ubuntu automatically sets users to
belong to the floppy group. This means you should have
permission to write to the floppy. If the device belongs to
the floppy group and the user belongs to the floppy group,
you should be able to mount the floppy and write to the
floppy. I do not understand why this does not work, but I
guess that it has something to do with the logical volume
manager.

So I find a way around the problem. I will tell you the answer
in a minute. First let me tell you some interesting things I find
when I search for the problem. When I install KDE on Ubuntu
Breezy Badger, KDE can mount the floppy. But it will not show
you the files in Konqueror. Konqueror just spins the loading icon
and never shows you the files. But I check and the floppy is
mounted.

So I try Kubuntu Breezy Badger. Kubuntu Breezy Badger does
not have any problems mounting or reading the floppy with
KDE! I do not understand this. I thought Kubuntu Breezy Badger
was the same as Ubuntu Breezy Badger with KDE. So why does
the floppy work in KDE on Kubuntu but not in KDE on Ubuntu?
I do not know. Now here is something even more crazy. If you
follow the directions on the KDE Web site to upgrade Kubuntu
Breezy Badger to use KDE 3.5, you get the same problem you
get with Ubuntu and KDE 3.4. You can mount the floppy, but
Konqueror will not show you the files.

Are you confused? So am I.
So here is how you can get around the problem. The answer

is the same whether you use KDE or GNOME. Press Alt-F2. This
lets you type in a command. Type the command:

mount /media/floppy0

This should mount your floppy. Now, use Nautilus or
Konqueror to go to the folder /media/floppy0. If you have files
on the floppy drive, you should see them in the Nautilus or
Konqueror window. You can drag and drop files to write files to
the floppy if the floppy is not write-protected.

Make sure to press Alt-F2 again and type this after you are
done:

umount /media/floppy0

You should not lose any data you write to the floppy if you
do this.

This should work for you. If it does not work, check the file
/etc/fstab. I think you are using GNOME, because you are using
Ubuntu. Open a terminal window and type this command:

sudo gedit /etc/fstab

Enter your password if it asks for one. Make sure you have
this line somewhere in the file:

/dev/fd0 /media/floppy0 auto rw,user,noauto 0 0

Make sure you have the directory /media/floppy0 on your sys-
tem too. You can make this directory yourself if it is not there.
Stay in your terminal window and type this command:

sudo mkdir /media/floppy0

You should not have to edit your /etc/fstab file, and you
should not have to make the directory /media/floppy0. But I give
you this information just in case.

Here is my last advice. Keep your Ubuntu system up to date.
Sooner or later someone who works on Ubuntu should fix this
problem and you will not have to work around it anymore.
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Q Dear Mango, 1) When logging in (init 5) under Simply Mepis (kernel:
2.6.7/2.4.2x) I get an X server with 1024x768 pixels and a resolution

of 100x100 dpi. On opening a second X session (console Alt-F2, GUI Alt-F8)
I get an X server with 1024x768 pixels and a resolution of 75x75 dpi. This
looks much nicer on my Laptop TFT screen. Why is this happening (the dif-
ference in resolution), and how can I set the desired resolution myself?

2) Simply Mepis uses KMail or Mozilla Mail and Mozilla as browser. I
downloaded and installed Thunderbird and Firefox (also jre). Although one
thing I can’t avoid is when I open a URL in Thunderbird, I automatically get
the Mozilla browser to open, and of course I would like to have Firefox
open instead. How do I go about that?

3) I am very pleased with Linux. My scanner, USB keys, digital camera
(USB mass storage), USB-multicard reader, external DVD-burner as well as
my wireless network (Linksys WPA54G + WPC54G with Broadcom chipset)
are all performing without any problem. What pleases me most of all is
that I nearly can drop MS Windows, if it were not for my USB-Conceptronic
MovieBox, which is an external 40GB HDD with incorporated multicard
reader. This is, until now, the only device that I can’t seem to get working
under Linux, though it is also a USB-mass storage device, which should
appear somewhere as a /dev/sd. If you could help me with this, MS
Windows is history forever.

Many thanks in advance, and keep up the good work.—Anonymous

A I do not do good work. I do perfect work. Even when I am wrong, I
am wrong perfectly. That does not happen often. I think I was per-

fectly wrong maybe once in June of 1999, but maybe I am wrong about
that. But if I am wrong about that, I am perfectly right that I was perfect-
ly wrong about that date.

1) I do not know why you get a different dpi setting when you open a sec-
ond X session. I do know how to change the default dpi setting. That should
fix your problem. Click on the K menu and select Mepis Config (OS Center) to
start the Mepis OS Control Center. Select Mouse and Display in the list on your
left. You should see what you see in Figure 1.

Select one of the settings, Larger, Medium or Smaller. These settings
change the dpi parameter that the KDE login manager uses when it starts
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Figure 2. The KDE Component Chooser

Figure 1. Mepis OS Control Center
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the X server. If you are geeky, maybe you would like to know
that the file it changes is /etc/kde3/kdm/Xstartup.

If it is set on Medium now, try setting it to Smaller. Click Apply.
Now you must log out and log in again. I think you will like that
setting best. If you do not, then try the other settings. I think
maybe Mepis looks at the display resolution before it changes the
dpi settings. This is how it works for me. Larger sets dpi to 120.
Medium sets dpi to 100. Smaller sets dpi to 75.

2) Maybe you use a different version of Mepis than me.
When I click on a URL in mail, it opens Konqueror not Mozilla.
My Mepis does not even install Mozilla. I must install it myself.
You cannot install Thunderbird from Mepis. You have to get it
from a Debian repository. I think maybe you installed many
things differently than me. I have Mozilla, Thunderbird and
Firefox. When I click on a URL in Thunderbird it opens Firefox.

I think I can answer your questions, even if your Mepis is differ-
ent from my Mepis.

Here is how to make Thunderbird open Firefox. You must
open a terminal and log in as the root user. Edit the file
/etc/mozilla-thunderbird/global-config.js. Be sure that you have
these two lines in this file:

pref("network.protocol-handler.app.http","mozilla-firefox");

pref("network.protocol-handler.app.https","mozilla-firefox");

If your Mepis starts Firefox with the command firefox
instead of mozilla-firefox, then you want to change these
lines to say firefox instead of mozilla-firefox.

If you have these two lines below, instead of the ones above,
that is the reason Thunderbird is opening Mozilla. Your Mepis
probably defines the x-www-browser as Mozilla. You can

change this setting in the /etc/alternatives directory, but I like my
way better (the one above):

pref("network.protocol-handler.app.http","x-www-browser");

pref("network.protocol-handler.app.https","x-www-browser");

Here is how to make KMail open a URL with your favorite Web
browser. Click on the K menu and select Control Center to open the
KDE Control Center. Then click on KDE Components→Component
Chooser. What you see looks like Figure 2. Click on Web Browser,
and then type the full path to your favorite Web browser. I use a
special version of Firefox, so mine says /usr/bin/firefox. You probably
will have to enter /usr/bin/mozilla-firefox instead. Click Apply, and
then close the Control Center. When you click on a URL in KMail, it
should open the URL with Firefox or whatever browser you picked.

3) I do not know what this is, the USB-Conceptronic
MovieBox. If you want me to tell you how to make it work, tell
the company to send me one, and I will make it work with
Linux. Then I will tell you how to do it.

Q I was wondering, how do you find the MIME types for
other file types? I was thinking about adding a right-click

to use par2repair for a par2 file, but I am stuck on figuring out
the right MIME type.—Nicholas Maliwacki

A What are par2 files? Are they not attachment parts of big-
ger files you download from Usenet? Are you downloading

porn movies from the Usenet? Maybe I should not help you do
this. Otaku wants to know why I am laughing. I do not worry.
You will not find any porn movies of me on the Usenet. I am
smarter than Paris Hilton or Pamela Anderson. And prettier too.
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I will think that whatever you
are doing is innocent. But I will
tell your wife to give you a
smack anyway.

You do not really need to
make a right-click action if you
want to define a new par2 file
type. Here is how to do that.
On some systems, you will click
the K menu then Settings→
KDE Components→File
Associations. On other sys-
tems, you will open the KDE
Control Panel and choose KDE

Components and then File Associations from the list on the
left. You will see a window like the one shown in Figure 3.

Click the Add button. Select the group multipart, and type
par2 in the edit field (see Figure 4). Click Ok.

Now you will see a window like the one in Figure 5, except it
will be empty. You need to fill in the information like I did. It
should be easy for you to figure out how to do this.

Now when you click on a file that has the extension .par2 it
will automatically run par2repair.�

I am a sweet, humble, delicate and very cute genius who is at your service to
answer your Linux questions. Send your questions to mango@tuxmagazine.com.
I am deeply sorry that I do not have time to respond to anyone directly by 
e-mail, but I will select as many questions as I can and answer them here.
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Figure 3. KDE File Associations

Figure 4. Creating the par2 Type

Figure 5. Filled in par2 Definition
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For the home musician, the new kid on the block
is Hydrogen, an open-source drum machine that
caters to the genuine drummer. Escaping the con-
fines of ordinary sequencer-designed software like
Fruity Loops, Hydrogen is advanced yet more
intuitive for creating standalone drum passages.
Available for Linux, Windows and Mac, and com-
bined with programs like Audacity, Hydrogen
should be the latest piece in the newly developing
arsenal of home musicians.

INSTALLATION
Installation is a breeze. Simply download the bina-
ry package at http://www.hydrogen-music.org/
?p=download, and click on it. Installation starts and
finishes in a few short seconds, with the only other
step being a prompt for you to press Enter. A new
icon is made on the desktop, and if it’s not there,
simply look under <your-home>/hydrogen-<version
#>/bin/, and click on the file hydrogen-<version #>.

LOOKING AROUND
When Hydrogen first starts, you probably will see four
things on screen: the main toolbar at the bottom, the
Song Editor, the Pattern Editor and the Mixer.

THE MAIN TOOLBAR
Starting on the left of the main toolbar is a count-
er showing how long your pattern has been play-
ing. Second on the toolbar are the playback con-

HHyyddrrooggeenn——TThhee
HHoommee  MMuussiicciiaann’’ss
FFrreeee  DDrruumm
MMaacchhiinnee,,  PPaarrtt  II
I don’t want to work, I just want to bang on my
drum all day. In this first installment of two parts,
John Knight covers installation, basic usage, exploring
general functions and making a basic song.

JOHN KNIGHT
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trols, with play/pause and stop, all doing the obvi-
ous. However, the fast-forward and rewind but-
tons jump forward and backward one bar/pattern.
The last button turns looping on and off.

Next on the toolbar is the mode switch, which
changes between Pattern and Song. Pattern mode
plays only the current pattern you’re working on,
whereas song mode plays through an entire
sequence of patterns later defined in the Song Editor.
Next in line is the BPM setting; click up or down to
decide how many beats per minute the song should
have. The bottom button is for toggling a
metronome, which plays a click on each major beat.

The last section is more advanced and won’t
be much use to beginners. The bar marked CPU
shows how much strain is being put on the CPU,
the Midi-in button allows you to see midi events
(too advanced for this article) and Jack Trans.
allows Hydrogen to be used by an external pro-
gram, provided a library called JACK is installed.

PATTERN EDITOR
At the top of the Pattern Editor are options for
configuring the pattern’s behavior. First on the left
is the pattern’s number, starting at 0. It is assigned
to the current pattern for use later on in the Song
Editor. Next is the pattern’s name, and then size
and resolution. Size determines how many beats
long the pattern will be, and curiously, it’s divided
into half beats. For normal 4/4 time, choose 8; for
3/4 time, choose 6 and so on.

Resolution is the best part about Hydrogen; it
allows you to divide each beat into more or less notes
at one time. Normally, it will be set to 8 (indicating
eighth notes in drumming terminology), which is the
standard division for a basic rock bar. If, perhaps, you
want to put in an Audioslave-style drum-fill at the
end of a bar (tah-kah-tah-kah!), this will require a
greater resolution of 16, or sixteenth notes.

For rapid-buzzing military-style snare drumming,
or blisteringly fast heavy-metal-style double-kick
drumming, choose thirty-second notes (32). Looking
further down the resolution list, you will see these
numbers again, but with a T. This indicates triplet
timing, which is a more advanced timing division
commonly found in music like jazz and waltz.

Last on the bar is a section with three buttons.
The first toggles the ability to hear notes as you
add them. The center button grabs notes if you’re
playing on the fly via the keyboard, or a midi-key-
board (see next issue’s article for more informa-
tion). The last button, labeled Q, automatically
places newly added keyboard notes in line with
the grid, which keeps things perfectly in time.

If you right-click on the instrument names on the
left, a menu comes up with a choice of Mute, Lock,
Solo, Clear Notes, Fill Notes and Randomize velocity.
Mute obviously mutes an instrument, and Solo runs
it by itself. Lock holds the current instrument’s line
of notes and keeps it there, allowing you to import
another drum kit without touching that instrument
or its notes. Clear Notes and Fill Notes lets you
either fill or clear the line in one swoop, which can
save a lot of clicking. Randomize velocity gives a
small variance between how hard each note is “hit”
on this line, providing a more dynamic feel.

SONG EDITOR
The Song Editor is where composition really
comes into play. The list on the left contains all of
the patterns you make in the Pattern Editor, the
field of squares on the right is a group of check
boxes that determine the sequence in which each
pattern will be played.

As for the buttons at the top, the Clear button
empties out the boxes on the right, letting you
start again. The plus sign creates a new pattern,
and the following up and down arrows let you

shift patterns up or down on the list if you are
uncomfortable with where they sit. The next two
buttons are Select Mode and Draw Mode. The first
allows you to click and drag boxes around the field
to move them into different places. If you click and
drag a box, you can select several at once (holding
right-click also does the same thing). The Draw
Mode (default) simply lets you click on each
square, which is where sequencing begins.

Right-clicking on the list of patterns allows you
to Edit, Copy, Delete, Fill/Clear or view the
Properties (which only renames the pattern for
now). Choosing Edit brings up the Pattern Editor.
Copy lets you take the pattern you’ve just made
and add something like a drum-fill, while keeping
the original pattern separate and intact. Delete
wipes the pattern off the list, and I haven’t seen an
undo anywhere, so be careful! Fill/Clear allows you
either to fill or clear a number of boxes in one go,
starting from one number and ending on another,
which can be handy for monotonous jobs where
you may otherwise need to click many boxes.

MIXER
With the mixer, you can control not only the overall
sound, but individual instruments as well. The first
thing you’ll notice are the vertical sliders; these let
you control the peak volume of each instrument.
The Master control on the right controls the global
volume, and above each instrument are controls for
playing each instrument solo, muting it, playing a
preview sound or shifting its balance left or right. To
the right of the Master control are the Humanize
controls. Drum machines have a bland feeling to
them, due to all the timing being perfect;
Hydrogen’s Humanizing option adds a little swing
with some random accents or slight imperfections
to make the sound more interesting.

Above the Master control is the option to mute
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all sound, and below that you can disable/enable the
peak cut-off range for the volume. The FX button
allows you to add further effects on the sound if you
download extra (LADSPA) sound plugins (see next
issue’s article). If you double-click on the name of an
instrument, an extra Instrument editor appears,
which lets you change the acoustics of each instru-
ment and add extra sound layers too. Above each
instrument’s slider are four knobs, which are used in
conjunction with the previously mentioned plugins.

MAKING MUSIC
Now that you have all that introductory informa-
tion, it’s time to have some fun and put it to use.
First, we’ll create a basic rock beat, and revisit
some of the previous information in the meantime.

1. Open the Pattern Editor, and if it looks blank,
scroll to the bottom. Make sure the size and
resolution are both set to 8, and look for the
line called Closed HH.

2. Click on the vertical lines for 1, 2, 3 and 4, and
the halfway lines after. (If you’re running in a
lower resolution, you may have to use the scroll-
bar on the bottom to move right along the page,
otherwise some of 4’s beats may be off-screen).
In drumming, this is counted as 1 + 2 + 3 + 4 +,
or one and two and three and four and..., with
each + being a minor note after each major note.
Click on the play button in the main toolbar, and
you’ll hear a steady pattern from the hi-hats.

3. On the Kick line, click on beats 1 and 3. The
beat will become more interesting.

4. On the Snare Rock line, click beats 2 and 4.

You now have a basic rock beat, but after a

few runs, it’s boring, isn’t it? First, we’ll spice up
the beat a touch, and then we’ll get Hydrogen to
add a large crash note on the first bar, plus an
Audioslave-style drum-fill on the fourth, using a
combination of the Pattern Editor, the Song Editor
and changing the resolution.

First, we’ll dress up the beat. For a very popular
beat, simply add another kick note on the + note
after 3. Play it back, and you can see what a dif-
ference a note or two can make. Now let’s turn it
into a full passage:

1. Bring up the Song Editor, and right-click on Pattern
1, click on Properties and rename it to Main Beat.

2. Right-click on Main Beat, choose Copy, and in
the new prompt window, call it Crash Bar.

3. Repeat these steps and make another called
Drum-Fill.

4. Move Crash Bar above Main Beat and Drum-Fill

below, using the move up/down buttons in the
top of the window to make these patterns easier
to access (Figure 2).

What we have just done is copy the original
pattern, so that we can alter it for Crash Bar and
Drum-Fill. Now to make the new bars:

1. Double-click on Crash Bar to bring up the
Pattern Editor.

2. Once in the editing screen, click the Crash note
on beat number 1.

3. Change to the Drum-Fill pattern (either click up
twice on the Pattern number or double-click
Drum-Fill in the Song Editor).

4. Remove the hi-hat notes from the two beats 4 +.

5. Change the resolution from 8 to 16 (which
allows a quick succession of notes).
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6. On the Snare Rock line, turn on beat 4
and the next three notes (these four
notes are usually referred to as 4e+a, or
foureeyander).

Now that we have the music out 
of the way, it’s time to bring the three
patterns together:

1. Change back to the Song Editor, and
make sure you scroll all the way up.

2. Check box 1 next to Crash Bar, 2 and 3
next to Main Beat, and 4 on the line
for Drum-Fill (Figure 6).

This will have created a basic rock
structured drum passage. To hear the whole
result, change the play mode from Pattern
to Song on the main toolbar, and click
Play. If you want to save this as a file any-
one can play, simply choose File→Export
song, and follow the prompts, where it will
be saved in .wav format.

TAKING THINGS FURTHER
Musically, there’s a lot more places you
can take your drum patterns, and there’s
no reason why you can’t compose an
entire musical piece, using many different
patterns and putting them all in place via
the Song Editor. Try playing around with
how many bars make a passage, different
tempos, time signatures, snare or kick
placements—the possibilities are endless
and are up to your imagination. Next
month, we will look at advanced usage,
tips and tricks, audio effects, making your
own kit and more.�

John Knight is a 21-
year-old, rock-climbing,
Japan-loving megaloma-
niac, trying to take over
the world from his bed-
room via his keyboard.
He spends most of his
time tinkering with

MPlayer and headbanging to his MP3s.
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Figures 3, 4 and 5. The Different Note Placements for Each Pattern

Figure 6. The Pattern Order for the New Song
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OpenOffice.org is the free, open-source office suite that runs on
Windows, Linux, Mac, Solaris and a host of other OSes like FreeBSD and
OS/2. It’s Microsoft Office-compatible, and it includes programs for text
editing, spreadsheets, presentations, drawings, creating or connecting to
databases, and forms and reports. It’s got native PDF creation so you
don’t need Distiller or another program to make a document from
OpenOffice.org that everyone can read.

It’s a pretty dandy program.
I think the only thing you can do with Microsoft Office that you can’t do

with OpenOffice.org is create huge, bloated, easily corrupted text files.
(Sorry—was that out loud?)

The much-anticipated OpenOffice.org 2.0 came out in October 2005.
One of the most significant improvements, along with the addition of
the database module, was the revamping of Impress, the presentation
program. This article explains how really, really good the new version is,
and also covers how to use updated features like the slide transitions,
custom animation and the Slide Sorter view. I also include a short walk-
through on how to create a presentation from scratch, for anyone who’s
new to the program with this version.

THE CHANGES IN IMPRESS 2.0
To grok the improvements and jump into this quickly, let’s take a look at the
old Impress, circa version 1.1.2 (Figure 1).

The navigation between slides was buried in tiny tabs at the bottom;
access to different views, such as handouts view, was buried in even
smaller icons on the right. Choosing a master page required knowing

OOppeennOOffffiiccee..oorrgg  IImmpprreessss  22..00::  tthhee  CCoonnffuussiinngg  
DDuucckklliinngg  BBeeccoommeess  aa  UUsseerr--FFrriieennddllyy  SSwwaann
Although it won’t help improve the quality of your presentation slides (at least not yet), the new
improved version of OpenOffice.org Impress makes it simple to create advanced presentations.
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Figure 1. OpenOffice.org Impress Version 1.1.2.
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that it was called a slide design (not to be confused with slide layout),
as well as performing one of the complex navigations to get to the slide
design selection window.

Now, take a look at Impress 2.0 (Figure 2).
Everything is sitting there, staring us in the face. There’s easy access to

each slide in the left-hand pane with really big thumbnails of the slides,
easy access to configuration options like slide layouts and effects in the
right-hand pane with clearly labeled titles, and across the top, there’s

easy access to different views of the presentation.
Some programmers might have merely tried to rework the old design.

But, this new version looks like a total rewrite, and it came out beautifully.
It’s easy to figure out, easy to use, and I haven’t found more than a few
bugs or design elements to complain about.

This is going to make teaching my Impress classes so much easier—and
of course, it will make learning Impress so much easier, not only because it’s
a nice design, but because it’s similar to the PowerPoint design. So,
PowerPoint users can download OpenOffice.org in the morning and be
bored expert users by lunch.

There are a few issues I’m not wild about—printing handouts, always
a bugaboo in the old version, is better but still in no way clear. (Use the
Handouts tab at the top of the work area and set the number of slides
per page, then choose File→Print, click Options and choose to print
handouts.) The “move along a line” feature, which is cool and very 
useful, seems to be gone, and the “infinite cycle” effect for custom 
animations is unreliable.

Aside from that, I’m extremely happy.
For the curious, see the following links for some information on the new

software from the OpenOffice.org site:

� http://marketing.openoffice.org/20/index.html

� http://marketing.openoffice.org/20/featureguide.html

� http://www.openoffice.org/product/impress.html

� http://www.openoffice.org/product/more.html

Enough about my opinion, let’s take a look at what you’re interested in—
how to make a presentation. Next, we’ll discuss how to use some of the
most useful features like the slide sorter, layouts, master pages, slide transi-
tions and custom animation.
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Figure 2. New Improved OpenOffice.org Version 2.0.
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CREATING A NEW PRESENTATION IN IMPRESS 2.0
After glowing about what a great idea it was for the Impress team to start from scratch
with the design, I’m forced to back-pedal a little and show something that’s still exactly the
same. The first window, in fact. Choose File→New→Presentation, and you’ll see the same
old window with the same old options (Figure 3).

However, they did cut down on the number of not-that-useful windows in the wizard, so
now there are only three. I like to select whatever I want, Blank or Template; and then simply
click Create in that first Wizard window, skipping the rest of the wizard (Figure 4). From here
on out, it’s a whole different program.

From this point, it’s very simple, because all
the elements you need are right there in the
interface or are logically located. Just click on
the thumbnail slide in the left-hand pane that
you want to work with, and it comes up in the
middle. Type your content, then go to the next
slide and repeat.

Run the presentation the same way as
before, by choosing Slide Show→Slide Show or
pressing F5.

CREATING SLIDES
To insert a new slide, click on the slide above
where you want your new slide, and choose
Insert→Slide (Figure 5). Or, you can right-click
under the slide and choose New Slide.

To delete a slide, select its thumbnail and
press your Delete key. Be forewarned, however,
Impress will delete the slide immediately, with-
out giving you an “Are You Sure?” warning.

REARRANGING SLIDES
If you suddenly realize that your Why We
Can’t Hit the Deadline slide belongs after
the Reasons We Need Raises slide, you can
change the order easily. In the left-hand
pane where you’ve been working, simply

SUITED UP
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Figure 3. Impress’ New Presentation Wizard

Figure 4. Blank Newly Created Presentation
Figure 5. Insert Slide Context Menu
from within the Slide Pane
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drag the thumbnail of the slide you want to
move to where you want it to be.

If you’ve got bigger changes or want to look
at the whole presentation at once, use the Slide
Sorter view. Click the Slide Sorter tab at the top,
and you’ll see this view (Figure 6).

Drag slides around to your heart’s content. In
addition, your options in this window include set-
ting the slide layout and hiding or showing a
slide. You can use the toolbar at the top of the
work area, or right-click on one or more slides, to
get more options (Figure 7).

Click the Normal tab at the top of the work area to get back to 
normal view.

APPLYING LAYOUTS
All slides don’t have the same elements—some slides have a place for a title,
a place for bullet points, a place for a graphic and so on. If you have a title
page, you probably want a place for the title but not for the bullets. If
you’ve got a slide chock full of text information, you’re going to need the
bullets and not much else. How do you control which elements are in your
slides? Simply choose from one of the many slide layouts in the right-hand
pane of your presentation (Figure 8).

(If you use a template, you don’t need to worry about this as much,
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Figure 6. Slide Sorter View Figure 8. Layout View within the Task Pane

Figure 7. Context Menu
within Slide Sorter View
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but if you’re making a presentation
or template from scratch, this is
definitely important.)

If I’ve added a new slide to a pres-
entation, the program gives me the
layout of the previous slide. If that is
not the layout I want, I simply find
the layout I want and click the
design. For example, if a slide has a
plain title-and-bullets layout, I click
the Layouts title on the right-hand
side, and click on a layout that has
the tooltip Title, Text (Figure 9). That
layout is applied to my slide, and I
now can type in the text I want for
the title, and I have a place to put
bullet points.

APPLYING AND CREATING MASTER
PAGES
It’s important to apply the right lay-
out, so you have the right places to
enter information in your slide.
However, now you want to control
how this information looks. You
could painfully format each slide one
at a time, but it’s easier to use the
master pages, create the formatting
once, and apply it again and again to
whatever slides need it.

In the right-hand pane, click on
the Master Pages title to see the
available master pages (Figure 10).

Select a slide, and then select the
master page you want for the select-
ed slide. Right-click on the master
page, and you’ll have the option to
apply it to the selected slide or to all

slides (Figure 11).
To make your own master page,

simply format the page, and then
apply it as you would any other master
page. Choose View→Master→Slide
Master, and do the page formatting
you want. Choose Format→Page to
change the background color, choose
Insert→Picture to add a background
graphic, or add graphical shapes like a
bar on the left side or a line under the
title. Of course, format the text and
apply the bullets you want. Then,
choose View→Normal, and you’ll see
the new master page in the right-hand
pane under the Master Pages title. You
can leave it as is so that it’s applied
only to one slide, or you can right-click
the current format now shown in the

Used in This Presentation View and
choose to apply the new master page
to all slides (Figure 12).

DOING SLIDE TRANSITIONS
Although not strictly necessary, you
can add drama or some loud noises
to wake up your audience with slide
transitions (Figure 13).

The slide transitions, along with
most of the other configuration
effects, are in the right-hand task
pane. Simply click on the Slide
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Figure 9. Example Tooltip for Title,
Text Layout

Figure 10. Master Pages View
within Task Pane

Figure 11. Apply Master Page 
Context Menu

Figure 12. Apply to All Slides Option

Figure 13. Actual Slide Transition in
Progress
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Transitions title, and you’ll see your
options (Figure 14).

Select the slide you want, select
an effect and a preview of the effect
will run.

There are hordes of options to set
as well (Figure 15). In the lower part of

the Slide Transitions pane area, you can
specify speed, sounds, when the effect
runs and to which slides the transition
applies. Unmark the Automatic Preview
if you’re using sounds or if you don’t
want to see the preview every time you
make a change.

DOING CUSTOM ANIMATION
Let’s say you have a slide talking
about a balloon release. You’ve got a
picture of a balloon or three, but it
would be nice to have the balloon
do something. You can do this with
custom animation.

Click the Custom Animation title
in the right-hand pane, and click
Add (Figure 16).

You’ll see a window full of pos-
sible effects. Click the Add custom
animation button, select the tran-
sition you want, the speed and any
other options, and then click OK

(Figure 17). The preview will run; 
if it doesn’t, you can click Play.
When you like what you see, 
click on another slide and insert 
a new slide.

Custom animation has far more
options than the slide transitions
we saw earlier. If you have three
balloons to apply effects to, for
instance, you can set them up to
run with different effects, sequen-
tially, at different speeds. You can
even have the first balloon’s effect
run when you click on an entirely
different object, and have each 
balloon in succession run its effect
three times, then fade to a different
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...IT WILL MAKE LEARNING
IMPRESS SO MUCH EASIER,

NOT ONLY BECAUSE 
IT’S A NICE DESIGN, BUT

BECAUSE IT’S SIMILAR 
TO THE POWERPOINT

DESIGN. SO, POWERPOINT
USERS CAN DOWNLOAD

OPENOFFICE.ORG IN THE
MORNING AND BE BORED

EXPERT USERS BY LUNCH.

Figure 15. All Slide Transition Options
within the Slide Translation View

Figure 16. Custom Animation View in
Task Pane.

Figure 17. Select Custom Animation
Options

Figure 14. Slide Transition Options
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color, or simply disappear. There
are a lot of options and they’re
not just cool looking. If you’re 
trying to demonstrate processes,
from a fire drill to a Gantt chart to
a UML sequence diagram, you can
really serve your audience well
with some clear, vivid information

in your presentations.
Add all of the effects you want,

then specify the basic order for how
your effects should run in the lower
part of the custom animation view
(Figure 18).

To get to a host of more effect
options, click the browse icon next
to properties; it’s kind of easy to
miss (Figure 19). The additional
effect options include things like
controlling what happens after the
effect runs, and also provides timing
options, like how many times to run
the effect.

WHAT NOW?
If you haven’t upgraded to
OpenOffice.org 2.0 yet, by all
means, do it now (2.0.1 is the latest
version). If you’ve tried to convert
reluctant managers, IT folks or
PowerPoint users with the 1.x ver-
sion, try again with 2.0. Impress 2.0
is easy for new users or PowerPoint
fans, it looks great and it opens
Microsoft Files beautifully.�

Solveig Haugland is an instructor, author
and course developer near Boulder,
Colorado. She got started with StarOffice
and OpenOffice.org while working in Sun
Educational Services, and wrote her first
book there, The StarOffice 5.2 Companion.
She is now an independent instructor and
author, teaching everywhere from
Winnipeg in December to Houston in
August. When not teaching, blogging, writ-
ing or haranguing passersby about how
cool OpenOffice.org is, Solveig can be
found swing dancing at the Mercury, skiing
at Copper and playing poker at Larry’s.
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Figure 19. Browse Icon for More
Effect Options

RESOURCES

Get tips about OpenOffice.org 
or StarOffice at Solveig’s blog:
http://openoffice.blogs.com.

Learn how to get OpenOffice.org
or StarOffice training for your
organization at Solveig’s Web site:
http://www.getopenoffice.org.

Find Solveig’s OpenOffice.org
and StarOffice books on
Amazon.com and from other
fine booksellers.

Figure 18. Change the Order of
Custom Animation Effects

IF YOU HAVEN’T
UPGRADED TO
OPENOFFICE.ORG 2.0
YET, BY ALL MEANS, 
DO IT NOW 
(2.0.1 IS THE 
LATEST VERSION).

http://openoffice.blogs.com
http://www.getopenoffice.org
http://www.Amazon.com
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Kopete is the KDE instant-messaging client. It supports a wide range of
protocols and ships with a great deal of plugins to extend its functionality.
Integration with KDE is one of its strongest points, with support for linking
contacts to KAddressBook entries to integrate IM functionality with Kontact.
With the coming of KDE 3.5, it even supports Webcams on MSN and Yahoo.

Most aspects of Kopete’s appearance and behaviour can be customised.
This flexibility can sometimes make Kopete’s configuration dialogs seem a
little overwhelming. This article takes a look at how to demystify some of
Kopete’s configuration options as well as how to get set up with some
common accounts.

SETTING UP ACCOUNTS
Kopete supports most popular IM protocols, including MSN Messenger,
Yahoo Messenger, ICQ, Jabber and AIM. It also has basic support for IRC.

The first time you launch Kopete, it takes you straight to the Select
Messaging Service dialog where you can create an account. To reach this dia-
log again, select Configure... from the Settings menu, and in the dialog that
appears, make sure you have Accounts selected in the icon bar to the left.
Then click the New... button.

Let’s take a look at adding an MSN Messenger and a Jabber account.
Setting up the other protocols is a similar process.

MSN MESSENGER
In our on-line worlds, most of us have buddy networks that span the globe
and probably include all popular services and operating systems. So it is
inevitable that ultimately we will have to communicate with loved ones who

KKDDEE  IInnssttaanntt  MMeessssaaggiinngg
For KDE enthusiasts, Kopete is a general-purpose instant-messenger client compatible with all major services. This article offers a quick introduction to Kopete’s flexibility.

JES HALL
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are using Microsoft Windows. To set up Kopete to
connect to the MSN Messenger network, you’ll
need a Microsoft Passport. If you already have
one, skip straight to the next section.

In the Select Messaging Service dialog, high-
light MSN Messenger and click Next. If you don’t
have a Microsoft Passport already, Kopete can help
you create one. Click the Register New Account
button, and your default browser will launch to
take you to the Microsoft Passport page.

You can use any valid e-mail address to sign up
for a Microsoft Passport. If you don’t already have
an e-mail address, you can optionally sign up for a
Hotmail account from this page. For this example,
I’m going to use my Gmail account.

Click continue on the Microsoft Passport
page to start the registration wizard. Fill in all of
the details, and click submit. The next step asks
you to read and agree to the Passport Network
Terms of Service and the Passport Network
Privacy Statement.

If you used something other than a Hotmail
account to sign up, you’ll need to confirm your e-
mail address. After completing the sign up
process, you should have an e-mail waiting for
you in the account you used to sign up with.
After following the instructions there, your e-mail
address is verified for use as a Microsoft Passport.

SIGNING IN WITH YOUR MICROSOFT PASSPORT
Enter your MSN Passport ID and password into
the appropriate forms on the wizard, and click
Next. Click Finish on the next screen, and Kopete
will connect to the MSN Messenger service.

JABBER
Jabber is an open, secure alternative IM protocol.
Jabber works a little differently from MSN or AIM
or other proprietary protocols. Most of those serv-
ices have a single centralised set of servers that
you connect to, controlled by the owners of the
protocol. There are hundreds of open Jabber
servers to choose from, or you could even run
your own. People on different servers are able to
contact each other.

Creating a Jabber account is usually done with-
in your Jabber client. In the Accounts configura-
tion dialog, select New... and choose Jabber from

the list of messaging services. In the Account
Information dialog, click Register New Account. In
the dialog that appears, you can browse a list of
public servers by clicking Choose. I already know a
server I’d like to try, kdetalk.net, a KDE Jabber
server for users and developers.

Fill in the name of the Jabber server you’ve
selected and the Jabber ID you would like to have
as well as a password. Jabber IDs usually take the
form of username@server, much like an e-mail
address. Here, I’m choosing canllaith@kdetalk.net.
If that user name is already taken, the server will
prompt me to try another one.

You can optionally turn on Use protocol
encryption to encrypt your traffic to the server.
Click Register and then Close. Back at the
Account Information dialog, optionally tick the
box to have Kopete remember your password and
click Next. Click Finish, and Kopete connects to
the new account.

ADDING BUDDIES
To add buddies or contacts, you’ll usually need to
know their e-mail addresses or user names for the
service to which you want to add them. To add a
buddy, either click the second button on Kopete’s
toolbar (usually depicting a star) or select Add
Contact from the File menu.

If the person you want to add has an entry
in your KDE address book, tick the box Use the
KDE address book for this contact to enable
linking the address book entry to your Kopete
contact. Select the address book entry for 
this contact (this step is skipped if you leave
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Figure 2. Registering a Jabber ID
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the box unticked), and click Next. Enter the
name you want your contact to have on your
contact list—this can be whatever you like. If
you want to create a group in which to put
your contact, you can do so here with the
Create New Group button.

Click Next, and select the account to which
you’d like to add the buddy. Here, I’m adding a
Jabber contact. Enter your contact’s ID on the next
screen and click Next, and then click Finish to see
your contact added to your list.

SENDING MESSAGES
To send a message to a contact, simply click on
his or her name in your contact list. Kopete obeys
the global KDE settings for single- or double-click.
By default, messages received show up as a small
bubble above the Kopete icon in your system tray.
If you prefer behaviour more like Gaim, you can
disable the bubble and the message queue in
Appearance→Events.

CUSTOMISING THE MESSAGE WINDOW
Most aspects of Kopete’s message windows can
be customised. The toolbars can be customised or
removed, and the formatting of messages can be
modified with stylesheets, fonts and different
emoticon sets.

Kopete includes several chat window 
styles, and more can be downloaded from
http://www.kde-look.org, under the Kopete
Styles section. To install a Kopete style you have
downloaded to disk, select Configure... from
the Settings menu. Select Appearance from the

icon bar to the left and then go to the Chat
Window tab. This is where you manage your
chat window styles.

Click Import underneath the preview win-
dow, and then in the dialog that appears,
select the XSL file (or the tarball containing 
it) that you downloaded. If the style is valid,
Kopete imports it and then displays the style 
in the preview window. Click OK to apply the
new style.

If Kopete displays an error message, it usually
means the style isn’t valid. Unfortunately, this
happens sometimes with user-contributed styles,

so simply try another one. If you sort the styles
by rating on http://www.kde-look.org, generally
the highest-rated ones are well-formed XSLT.

Emoticon themes also can be downloaded
from http://www.kde-look.org and installed in
much the same way. Once you’ve downloaded
an emoticon theme, you then can install it
using the Install theme file... button underneath
the emotion preview under Appearance on the
Emoticons tab.

“That’s all pretty nice”, I hear you say. “But
Gaim does tabs!”

Kopete also has this functionality, but it’s
not enabled by default. You can enable them
in Behaviour→Chat, by modifying the Chat
Window Grouping Policy. It’s extremely flexible,
allowing you to define whether you want mes-
sages from all contacts to open in tabs in the
same window, as Gaim does, or whether you
want to tab contacts together based on which
group they are in or what account they are
added to.

Kopete has a wide range of configuration
options not covered here. For more information,
try the Kopete handbook or talk to the developers
on irc.freenode.net in #kopete.�

Jes Hall is a UNIX systems consultant
and KDE developer from New
Zealand. She’s passionate about
helping open-source software bring
life-changing information and tools
to those who would otherwise not
have them.
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Figure 3. Kopete’s Messaging Window
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Back in the early nineties, I fell in love with a new personal computer
database product, Access. After spending many years working with
Dbase and Paradox, working with Microsoft Access was a real joy. It 
provided superb integration with Microsoft Office and thus provided
new-found functionality and reach for small and home offices. With the
OpenOffice.org 2.0 Base module, it is now possible to create and use
small database applications easily with Linux. By simply learning how 
to use the wizards available in Base, it is possible to create a simple
application with forms and reports.

As Microsoft Access matured, it became a favorite for independent soft-
ware vendors and helped launch many young companies into business. From
what I have seen, OpenOffice.org Base may be ready for that same future.
Combined with OpenOffice.org basic and a little bit more development from
the community, Base could become an even more valuable addition to the
OpenOffice.org suite.

In this tutorial, I present a simple and fast way to create a single table
application using the wizards available within OpenOffice.org Base. In addi-
tion to the wizards, Base delivers full editing capabilities for Tables, Views,
Queries, Forms and Reports. These editors provide complete control over the
powerful features available in Base; however, they are beyond the scope of
this tutorial.

For those TUX readers who might have a new exercise program as part of
their New Year’s resolution, this tutorial will help you create an easy-to-use
exercise log to keep track of your progress. Through this tutorial, I explain
how to create a new database, a new table and a data-entry form to track
your exercise routine.

ESSENTIAL ASSUMPTIONS
To complete this tutorial, you need to have version 2.0 or higher of the
OpenOffice.org multilingual office suite installed. The Base component is one
of the new features of version 2.0, and it allows for the seamless integration
of database access within OpenOffice.org 2.0. Base permits access to a wide
range of native database formats or enables creation of databases using
Base’s internal HSQL database engine.

Those familiar with the operation of databases can skip this brief intro-
duction to database functionality and proceed to the first step of creating a
new database. To simplify, a database is like a collection of one or more
spreadsheets, which are composed of rows and columns. Each row should
be uniquely identifiable, which enables searching for specific records. Each
record typically consists of the unique identifier and one or more columns,
and each column has a unique name and may contain a wide variety of
data. It is possible to relate multiple spreadsheets (tables in database termi-
nology) by associating records from one table to a column of another table.
This feature of databases gives them the power and flexibility to capture
complex data relationships and makes the data easy to combine and manip-
ulate. For this reason, databases are an essential component of any applica-
tion, which explains their popularity in software development.

CREATING A NEW DATABASE
From any OpenOffice.org component, select File→New→Database, and
OpenOffice.org presents the OOo Database Wizard. The Database Wizard
guides the database creation process. The process consists of two main
steps: select a database and then save and proceed. In the first step of the
process, you decide whether you want to create a new database, open an

OOppeennOOffffiiccee..oorrgg  BBaassee
Looking for a simple, yet powerful, tool to help organize your work or life? The new OpenOffice.org 
component Base may be just what you need to gain control over your photograph, DVD or CD collections.

KEVIN SHOCKEY
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existing database or connect to an existing database (Figure 1).
For this tutorial, we use the Create New Database option, but it is useful

to know that OpenOffice.org Base also can serve as a data-entry and report-
ing tool for other popular databases natively. These databases include MySQL
and Oracle using JDBC, and OOo Base also can connect to popular e-mail
client databases from Mozilla Thunderbird or Evolution. With the latter con-
nectivity capabilities, it is simple to complete a mail merge using a contact
database. With the additional query functionality, Base provides accurate
control over address selections.

To begin the database creation process, leave the Create a new database
option selected, and click the Next button. The Database Wizard displays the
second step in the process, which requires deciding two things. First, decide
whether you want to register the database within OpenOffice.org and sec-
ond what you want to do after creating the database. Registering the data-
base informs OpenOffice.org, among other things, of where to locate the

data and how it is organized. Registering the database also makes the data
available to all of the OpenOffice.org components. If you don’t register
the database at this time, you always can register it later using the
Tool→Options→OpenOffice.org Base→Databases→New option. From this
dialog, you can administer all databases within OpenOffice.org. To access a
database from within another OpenOffice.org component, use View→Data
Sources. To proceed with our tutorial, I recommend leaving on the default
option of registering the database.

The second decision you need to make is fairly self explanatory. I 
recommend selecting both options—to open the database for editing and
create tables using the Table Wizard (Figure 2). Click on the Finish button 
to continue. The Database Wizard then prompts you for a filename and 
location. Enter the desired name, select a location and click the Save button.
OpenOffice.org saves the database file, opens the new database and starts
the Table Wizard.
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CREATE A NEW TABLE
The Table Wizard consists of four steps: selecting fields from sample tables,
setting the types and formats for the selected fields, setting the primary key
for the table and creating the table. The first step in the wizard provides a
wide variety of sample tables for choosing the desired fields of your new
table. First, choose whether you want to select fields from categories of
tables useful for business or for personal purposes. When you choose a cate-
gory, the list of available tables changes accordingly. There are 22 different
sample tables to choose from within the business category, including Orders,
Projects and Transactions. Within the personal category, there are 15 sample
tables, with options such as Exercise Log, CD Collection and Recipes.

After you select a category and a sample table, the Table Wizard displays
a list of available fields. You can use the > or >> buttons to select individual
fields or all fields. Use the < or << buttons to remove individual fields or all
fields, respectively. You also can mix fields from multiple sample tables to 
create a table that meets your exact needs, and you can reorder the selected
fields using the up and down arrows.

Continuing with our exercise log database, select the personal 

category, select the ExerciseLog table from the list box, select all fields
using the >> button and then individually remove the CaloriesBurned
and DistanceTraveled fields. I also rearranged the order of the fields—
placing the LogId first, the PersonId second and moving the Notes field
to last. Due to the flexibility of databases, the order of columns is merely
cosmetic, because you always can reorder the fields with views and
queries, or from within the form designer or the report designer. When
complete, your dialog should resemble Figure 3. Click on the Next button
to advance to the second step of the process.

In step two of the Table Wizard, you determine the names, types and
lengths for the fields selected in the first step. In addition, you also need to
determine whether the fields will use the AutoValue feature and whether
data entry is required for the fields. Each of the fields already will have the
defaults inherited from the original sample table. All fields are set by default
not to use the AutoValue feature and not to require data entry. From this
dialog, you also can delete fields from the field list using the minus button
and add new fields using the plus button. The up and down arrows let you
move between the different fields. This step is illustrated in Figure 4.
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Figure 3. Step One in the Table Wizard Figure 4. Set Type and Formats Step in Table Wizard
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In our exercise log database, I recommend keeping all of the default
types and formats. To ease the table creation process, change the LogId
field to use the AutoValue feature. This helps us create a unique identifi-
cation value for each new record we insert into the table. As you will see
in the next step, this simplifies selecting a primary key. With the LogId
field selected in the Selected Fields list, choose Yes from the AutoValue
list box. This automatically changes the options. Because AutoValue
ensures that the field will be auto-incremented, it will always have a
value. So instead of the Entry required field information option, the wiz-
ard automatically changes the option to Auto-increment statement with
a value of IDENTITY. It is important that you do not alter this value, or it
will cause an error in the create table step. Click the Next button to
advance to the next step.

In step three, the Table Wizard guides you in creating a primary key
for your new table. A primary key is the index a database uses to access
records directly within a table. It is a shortcut that helps the database
find specific records within a table. Although the Table Wizard makes it
appear that creating a primary key is optional, it will cause an error if

you attempt to save the table without creating one. Because we made
the LogId field use auto-increment, selecting the primary key for our
table is simple. Select the Use an existing field as a primary key, and
select the LogId field from the list. Keep the AutoValue option selected.
When complete, your dialog should resemble Figure 5. Click the Next
button to proceed to the final step of the wizard.

The final step of the Table Wizard requires selecting a name for your
table and deciding what you want to do next. In the first part of the dia-
log, the text box should contain the name of the sample table if one was
used. After choosing a name for your table, you have provided all of the
information necessary to create your table. The final option determines
what you want to do next. You can open the table in grid or spreadsheet
form and immediately begin to enter data, you can open the table editor
and fine-tune the design of your table or you can invoke the Form Wizard
using the table you will create.

Because we based our table on the ExerciseLog table, that should be
listed as the name for our table (Figure 6). Type in a new name or a
more descriptive one if desired. We intend to create a data-entry form
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for our table, so select the Create a form based on this table option and
click the Next button. OpenOffice.org should save the table and launch
the Form Wizard.

CREATE A NEW FORM
The OpenOffice.org Form Wizard seems complicated, but it is fairly sim-
ple. Although it contains eight steps, only five steps are necessary for
most forms. Excluding the creation of forms that include forms (sub-
forms), the steps to create a form using the Form Wizard are selecting
the fields, arranging the controls, setting the data-entry mode, applying
styles to the form and setting the name.

The first step here is nearly identical to first step of the Table Wizard. The
big difference is the source for the fields must be either from tables or
queries that exist in the current database. Otherwise, the same buttons are
available to select or remove fields from the form. All of the fields chosen
must be available within one table or query. As we launched the Form
Wizard from within the Table Wizard, the ExerciseLog table is chosen by

default. Select all of the fields using the >> button, and then remove the
LogId. Because it is incremented automatically, it is not required for the form.
Click the Next button. The Form Wizard presents the next step in the
process. As subforms are beyond the scope of this article, simply leave the
Add subform check box blank. Click the Next button, and the Form Wizard
jumps to the arrange controls step.

With the fields selected, the next step requires arranging the fields on the
form. The Form Wizard uses only simple text controls. There are four
options, and the order in which they appear, from left to right, is Columnar -
Labels Left, Columnar - Labels on Top, As Data Sheet and In Blocks - Labels
Above. If your selection is Columnar - Labels Left, you also can choose the
label placement. Although the labels remain on the left of the data, you can
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choose whether you want the
labels aligned flush left to the
edge of the form or right
against the data itself.

With our exercise database
application, I chose the
Columnar - Labels Left with
the labels aligned left. Click on
the first option in the
Arrangement of the main form
section. Align left should be
selected by default (Figure 7).
Click the Next button to set
the data-entry mode.

Building multiple forms to
handle only data entry and
only data modification is
beyond the scope of this arti-
cle. For our purposes, we
want the simplicity of
adding, modifying and delet-
ing records from within our
exercise log form. Select The
form is to display all data option, and leave all of the sub-
options blank, allowing us to add, modify or delete data.
Click the Next button to select a style for your form.

The form dialog contains two options. First, choose a
color style. In the Apply styles list box for our exercise log
form, I selected the Bright Blue option. You also need to
select a style for the field border. The mutually exclusive
options are No border, 3D look and Flat. If not already select-
ed, click the 3D look. You may have noticed that as you
select options, the form changes in the background to reflect
your choices. Figure 8 illustrates this effect. Click the Next
button to complete the final dialog and create the form.

Finally, enter the name of your form in the Name of the form

text box and choose what you want to do. Click on the Work with
the form option and click on the Next button. If the form creation
process is successful, your form should resemble Figure 9.

The form that results from the Form Wizard, as illustrated
in Figure 9, is actually displayed using OpenOffice.org Writer.
In a following article, I’ll cover the importance of this feature,
which also shows up in the reports functionality as well. By
combining these features, OpenOffice.org brings new-found
simplicity to common home and small-office tasks. One
example is the new Mail Merge Wizard that combines Base
with Writer to provide powerful new functionality. I’ll con-
clude my discussion of this application and also explain how
to use the new Mail Merge Wizard in the March issue.�
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Figure 9. Completed Exercise Log Form

Kevin Shockey is 
Editor in Chief of TUX.
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One of the sad ironies of this new world of
wireless multimedia sharing is that although
many gadgets out there use an integrated
Linux OS to get music from point A to point
B, very few of them actually allow Linux
users to indulge in music-sharing fun. Enter
the Sonos Digital Music System.

The Sonos system is called a system for a
couple of reasons. First of all, it’s split up into
components rather than being an all-in-one
solution. The basic setup consists of a wire-
less base station, known as the ZonePlayer,
and a portable handheld remote control,
known as the Controller.

Second, it’s designed to be a multiroom
solution. You can place up to 32 ZonePlayers
and Controllers around your house or work-
place and stream different tracks to each of
the different zones.

THE ZONEPLAYER ($499 US EACH)
The ZonePlayer is the heart of the system. It’s
designed to connect to your home network,
stream music from shared folders on your local
home network and communicate wirelessly with
other ZonePlayers in your house.

The first ZonePlayer you hook up in your home
must connect to your home network using an
Ethernet connection; additional ZonePlayers then
will connect wirelessly through the first ZonePlayer
using a proprietary wireless networking system
called Sonosnet, in order to minimize interference

from other wireless equipment in your home. If
you want to place the first ZonePlayer in a room
that doesn’t already have an Ethernet connection,
your choices will be fairly limited, but you can get
around the issue with a pair of powerline net-
working adapters.

Whereas most wireless music systems are
designed to be connected to an audio system
that’s already in a room—whether it’s a television,
home theatre system or just a boombox—the

ZonePlayer is designed to be used without such
external audio/video equipment. The bad news is
you’ll need a set of speakers for each ZonePlayer
you set up. The good news is that you can use a
set of standard speakers you already have, so long
as they connect via bare wire at the ends. (If you
don’t have speakers, you can buy matched sets
from Sonos too.)

Although each ZonePlayer can stream a differ-
ent song at the same time, you also can link more
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than one of them together to act as a single enti-
ty. In other words, you can link up the player in
your living room with the one in your dining
room, or link the one in your workshop with the
one in the garage. You even can link all of them
together in party mode so that your music plays
throughout the house. Or, of course, you can play
different tracks in each of your defined zones.

Adding additional ZonePlayers is a fairly easy
process. You go to the System Settings option on
the Controller, choose Add a Zone Player, and
then press the buttons on the front of the new
ZonePlayer. Then you select a name for the
new ZonePlayer, and you’re done. Simple.

THE CONTROLLER ($399 US)
To make the ZonePlayers work, you’ll need at least
one Controller module. The Controller is exactly
what you’d think—a mobile remote control unit
that allows you to control what music is playing in
what zone. You can use a Controller in each
room, or you can control your whole network of
ZonePlayers from a single Controller unit.

If you’ve ever used an iPod, you’ll find the
interface on the Controller to be amazingly sim-
ple—like the iPod, it has a circular wheel for
scrolling, with a button in the center for selecting
your choice. There are also player controls
(play/pause, back and forward), volume controls, a
mute button and menu buttons for selecting your
zones and accepting commands.

The key to the Controller module is a large
color screen in the middle of the front panel. The
screen makes it easy to sort through your music
library, choose between multiple zones in your
house and set up the system. You can even dis-
play album artwork on the screen, if you have it
saved in your music library.

The controller has a built-in rechargeable bat-
tery, and it comes with an AC power adapter. If
you want to invest a bit more, you can get a wall-
mountable charging cradle for $50 US, which also

will help ensure that the Controller doesn’t get
misplaced between uses.

THE SYSTEM
The ability of the Sonos system to play music in
multiple zones around the house is already
impressive enough, but the thing that impressed
me the most was the way that the system finds
and retrieves music.

With most wireless music players, you’re typi-
cally limited to streaming your music from a single

REVIEWS

49www.tuxmagazine.com

WHEREAS MOST WIRELESS MUSIC SYSTEMS ARE DESIGNED TO BE CONNECTED TO AN AUDIO SYSTEM 
THAT’S ALREADY IN A ROOM—WHETHER IT’S A TELEVISION, HOME THEATRE SYSTEM OR JUST A BOOMBOX—

THE ZONEPLAYER IS DESIGNED TO BE USED WITHOUT SUCH EXTERNAL AUDIO/VIDEO EQUIPMENT.

Sonos Controller

http://www.tuxmagazine.com


computer, and most of the time it has to be a
Windows machine. The Sonos system, on the
other hand, can retrieve music from up to 16 dif-
ferent sources on the same network, and it does-
n’t matter whether those shared folders are on a
Windows machine, a Mac, a Linux box or even a
Network Attached Storage drive. The only require-
ment is that the folders have to be shared, and
they have to be on the same network that the
first ZonePlayer is connected to.

The one downside for Linux users is that a
bit of manual setup may be required. Although
the Sonos system ships with client and setup
software for Windows and Mac, the Linux
installation is a bit trickier. That said, I was able
to set it up myself in about an hour, and I’m
pretty much still a newbie when it comes to
understanding what’s going on behind the
hood on a Linux machine. In other words, if
you’re willing to spend a bit of time on it, you
can do it too, even if you’re still a newbie.

MANUAL CONFIGURATION FOR LINUX
If you go to the Sonos Web site
(http://www.sonos.com), you can search the FAQ
documents under the Support section for the term
“Linux”, and one of the documents that will pop
up shows you how to configure a Red Hat system
manually. Other distributions will vary and aren’t
officially supported by Sonos, but you can use the
find files option from your version of Linux to
locate the files you’ll need to edit.

The first thing you’ll need to do is log in as a
system administrator and change the permission
on your music folder so that it’s readable by all
users, even on other computers. (From the com-
mand line, this would be a chmod 0755 command

on the folder itself.) If your music is scattered
throughout your Linux machine, you may want to
consider consolidating it in one place to make this
process easier.

After doing this, you need to ensure that the
Samba file-sharing protocol is turned on, and
that it launches every time your system boots
up. Samba is what the Sonos system uses to
retrieve data from computers or network drives,
and luckily it’s a part of recent Linux distribu-
tions. You’ll also need to add a network share
for your music folder in the Samba configuration
file. The exact text you’ll need to add is listed in
the support document at the Sonos site, so you
don’t even have to worry about figuring out the
syntax. In fact, the hardest part, if you’re a Linux
newbie, will probably be figuring out how to
save the changes to your config file once you’ve
added the extra text! (As is standard practice
when you’re playing around with system files,
make a backup first, and if you’re new to the
editors found on a Linux machine, play around
with a few fake files first to make sure you
know how everything works, before you go
messing around with crucial files.)

If your distribution of Linux comes with a
built-in firewall, you’ll also want to figure out a
way either to turn the firewall off altogether or to
punch a hole through the firewall specifically to
allow Samba file sharing. Turning off the firewall
isn’t generally considered stellar security practice,
but it may be an option if you’re using a dedicated
box that’s already behind another hardware fire-
wall. If you’d prefer simply to punch a hole
through the firewall, you may be able to find
support documents telling you how to enable
Samba for your distribution simply by Googling

“Samba firewall [your distribution name here]”.
One example can be found here, for the SUSE
desktop: http://www.novell.com/coolsolutions/
feature/11952.html.

THE VERDICT
The ability to pull from Samba shares alone may
be worth the investment for music fans who
love Linux—or is that Linux fans who love
music?—because with minimal hardware invest-
ment, you can build a Linux box specifically for
sharing your music and then tuck it away in a
closet somewhere so that your music is always
available, even when your main workstation is
powered down.

Yes, the Sonos system is expensive. Yes, a bit
of manual configuration probably will be required
if you’re using Linux. Yes, it probably will be a bit
confusing for the Linux beginner.

But, if you have a bit of mad money to spend,
it’s well worth the investment. The ability to
stream to and from multiple locations (at least
when using a small number of ZonePlayers—I
couldn’t wrangle up 32 of them, alas) seems to
work exactly as advertised.�

Sean Carruthers is a freelance technol-
ogy journalist from Toronto. He spent
six years at Canada Computer Paper,
first as Products Editor at The
Computer and later at HUB Digital
Living magazine. As a freelancer, he
has written for the Globe and Mail,

http://globetechnology.com, HUB Digital Living, Computer
Dealer News, Homefront and CE-Biz. Although a relative
newbie with Linux (SUSE, thank you very much), he has
extensive experience with tech gadgets of all sorts and is
enjoying figuring out which ones are compatible with Linux.
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Recently, the Mozilla foundation released
Firefox 1.5, a major update to our favourite
Web browser that benefits from a large num-
ber of bug fixes, enhancements and interest-
ing new features.

The first new feature introduced in this new
version is an automated update system that
looks for the latest release or revision to the
browser, and if one is available, it automatically
downloads it, installs it and migrates your
browser settings to the new version.

This feature does make a little more
sense on the Windows platform than on
most Linux distributions, because the pack-
age manager on your Linux distro will auto-
matically download the latest version and
install it for you the next time you run it.
Windows cannot and likely will never be
able to update and support third-party
packages (Google Pack appears to be pretty
good at doing this for a hand-picked selec-
tion of packages, though).

The real benefit of this feature is that when
a new security vulnerability is discovered that
targets Firefox, once a patch for that vulnerabili-
ty is released, a vast majority of Firefox deploy-
ments will be updated so quickly that exploits
for this vulnerability will become obsolete.

Another, more obvious, benefit of the
automated update system is that when a new
major version of the browser is released, users
immediately can benefit from all the cool new
features, bug fixes and enhancements of that
latest release.

Another very neat addition to Firefox 1.5 is

the Clear Private Data tool that basically offers
you a way to specify which possible private
data you would like to be able to delete
through the tool, and then have it clear only
those elements when you run its shortcut.

If you frequently clear the same elements on
your browser, this allows you to automate this
process completely. The components available for
you to select are cookies, browsing history, saved
form information, cache, saved passwords,
download history and authenticated sessions.

On the enhancements side of things, I have
noticed some serious performance improvements
in terms of rendering time for very large pages, to
the point where it makes many other browsers
seem very slow to surf with in comparison.

Another enhancement you easily will spot is
the face lift that was applied to the Preferences
dialog, which features a completely new layout
and makes things a little easier to configure.

If you are just now discovering Firefox, anoth-
er major feature that Firefox 1.0 was already pro-
viding, and that you will also find in 1.5, is a very
powerful extension system that allows you to
download and install extensions for the browser.

The Flashblock extension, for example, is
one I find very useful, because it disables all
Flash animation on any Web page not on its
whitelist and replaces it with a graphic of the
same dimensions so the layout of the site does
not get broken by the removal of the Flash
animation. If you want to see the animation,
simply click on it, and if you want to add it to
your whitelist so Flash animations from that
site always show up, simply right-click on it
and add it to the whitelist.

This is extremely useful because of the
ridiculous amount of virtual memory Firefox

REVIEWS

51www.tuxmagazine.com

Mozilla Firefox 1.5

Figure 1. The New Automated Update System

Figure 2. Clear Private Data

http://www.tuxmagazine.com


consumes when you are browsing pages with Flash
animations, so although I don’t mind the performance
hit if I am looking at the animation, this is not a sacri-
fice I’m willing to make if the animation is advertising
that I am not even going to look at.

Another cool extension you should try out is FireFTP.
When enabled, this extension allows you to turn Firefox
into a complete FTP client. The interface is easy to use,
and the application is surprisingly responsive and reliable.

— X a v i e r  S p r i e t
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Figure 3. New Privacy Tab in the Preferences Dialog

Figure 4. Kill annoying flash banners with Flashblock. Figure 5. FireFTP

Mozilla Firefox 1.5

• License: Netscape Public License
(NPL), Mozilla Public License (MPL),
GNU General Public License (GPL)
and LGPL

• Web site: http://www.mozilla.com
• Price: Free
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The computer keyboard is the best
compromise between usability, relia-
bility and productivity for people to
provide input to a computer, and it is
especially well suited for entering
text and numbers, but you may have
noticed that some characters are
simply missing.

The written constructs used in
mathematics do not exist on our key-
boards, which makes it particularly dif-
ficult to represent any formula or equa-
tion you want in your documents. This
constraint can be especially frustrating
if you are currently studying statistics,
calculus or physics, for example.

Fortunately, an application such
as OpenOffice.org Math offers you
ways not only to create and man-
age representations for formulas or
equations using any common con-
struct and symbol, but it also allows
you to use these formulas in any
OpenOffice.org document.

If you are studying science or are
working frequently with statistics, for
example, Math 2.0 allows you to
port your formulas into your class
notes, archives or even presentations
and Web pages.

Math 2.0 allows you to create
formulas in three different ways:

� By clicking on buttons represent-

ing symbols in the selection box.

� By right-clicking in the text input
area (bottom) and selecting the
construct you are looking for from
the context menu.

� By entering special marked-up
representation of the constructs.

The “tagged” representation of
any formula is visible from the main
window, so whatever input method
you feel like using, every time you
work with a formula, you will learn a
little more about the tags and easily
will be able to use them to create
formulas later on—it’s a lot faster
than clicking on all the buttons for a
complete formula.

Another important thing to note is
that hovering your mouse cursor over
any of the buttons in the selection box
for about a second reveals a tooltip
explaining what that symbol is. You
are not expected to know exactly what
each button is simply by looking at it.

Let’s look more closely at an exam-
ple we’ve all been exposed to in some
shape or other. We will use OOo Math
to create the formula to calculate the
mean average of a set. We will create
that example using the selection tool-
box and then look at the text represen-

tation of it. Then, we’ll
embed this formula in an
OOo Writer document.

To create this formula,
follow this short set of
instructions:

� Click the Attributes but-
ton on the top part of
the selection toolbox.

� Click the line above but-
ton (second line of the
bottom part of the box).

� In the textbox, you
should see the string
<?> highlighted. Replace
it with the letter x.

� Still in the textbox,
enter a space, the
equal sign, followed
by another space.

� Click the Operators button (last in
the first row of the top section of
the toolbar).

� Select the Sum entry, and notice
that the <?> in the text area is
highlighted, leave it selected.

� Click the Unary/Binary Operators
button (first on the left in the top
section of the toolbox).

� Select the division (Fraction) entry

from the bottom of the toolbox.
Notice that Math added over <?>
to the formula. The first <?> still
should be highlighted.

� Click the Formats button (last in
the second row of the top section
of the toolbox).

� Select the Subscript Right entry.
Notice that it replaced the <?>
with <?>_{<?>}. Now let’s replace
all the place holders with variables
and finish the formula.
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� Replace the first <?> in the text
area with the letter x, and replace
{<?>} with the letter i.

� Replace the last placeholder with n.

This method of creating formulas
is straightforward but a little convo-
luted. It would work out just fine if
we rarely had to translate formulas
in documents, but it is inefficient if
you need to create new formulas fre-
quently. Fortunately, you may have
noticed that the text area updates
every time you make a selection,
so you can see what the mark-up
language looks like.

In the context of our example,
the generated mark-up representa-
tion of our formula looks like this:

bar x = sum x_i over n
The mark-up is actually pretty

simple for this formula, and it is also
rather straightforward. You also can
fine-tune the formula by implement-
ing brackets, exactly as you would in
traditional mathematics.

The documentation for OOo
Math 2.0 also covers some of the
mark-up constructs, but I found
experimentation to be the quickest
way to learn them in this case.

Now that we’ve created a formu-
la, we need to save it so we can
store our entire library of formulas for
use in all kinds of documents. Simply
click on the File menu, and select the
Save As entry to save your file.

Let’s provide some context for
our new formulas. First, open OOo
Writer 2.0 and start a new document.
Once you have Writer loaded, there
are two ways to insert formulas into
your document. The first one involves
loading a formula you have previously
saved in your library, and the second
involves creating the formula right
from the context of your document.

Click on the Insert menu entry, then
the Object menu entry, and select the
Formula entry at the bottom of the list.
A new instance of OOo Math will start
within Writer and allow you to create a
new formula. If you intend to create
this formula from within Writer, you
can do so at this point, but you will
lose the ability to save your formula, so
if you intend to re-use this formula
later, I would recommend creating it in
OOo Math and saving it first.

While still in the new formula, if
you would like to load an existing for-
mula, click on the Tools menu, and
select the Import Formula entry. Then
select the file associated with the for-
mula you had previously created with
Math. Your formula now is inserted
automatically in your document.

In Figure 2, we have added a little
bit of context to illustrate how for-
mulas are aligned. Although when a
formula is selected inside Writer, the
formatting toolbar changes to allow
you to change the alignment, the
border style and colour, and even the
background image of the formula. If

you would like to customize the for-
mula object further, you can right-
click on it and click the Object entry
in the context menu. You won’t be
able to change the font colour from
there, but you will have access to a
lot of additional options. If you want
to edit the formula, you can right-
click on it, and then click on the Edit
entry in the context menu.

Now that we have created a
working document featuring a cou-
ple of formatted formulas, we can
use OpenOffice.org’s Export function
(from the File menu) to export our
document to a PDF format or print it.

This should cover the needs of
students who want to store their lec-
ture notes as documents as well as
professionals who need to include
formulas in their documentation.

— X a v i e r  S p r i e t
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On the free gaming scene for the last couple of
years, Neverball is a popular 3-D puzzle/arcade
game in the style of Marble Madness and 
The Labyrinth. The basic idea of the game is 
to move the ball in the center of the screen
around a maze, collect a certain number of
items and make it to an exit within a certain
time limit. The hard part is that you tilt the
world instead of moving the ball, and the con-
trols are more sensitive than Lucille Ball in a
maternity ward!

The controls are quite simple. The (hyper-
sensitive) mouse moves the world around, 
and the left and right mouse buttons rotate
the camera. F1, F2 and F3 also change
between chasing camera angles, with Chase,
Lazy and Manual. Graphically, Neverball is quite
pretty, especially for a free game. There are
constant translucent effects, including see-
through platforms, and many of the anima-
tions, even the ball itself are see-through! The
color is always cartoony, which helps keep a
fun atmosphere, and the sky is simple, serene
and often changing.

Of course, these effects don’t come easily,
and you will want somewhere around a
GeForce 2 onward for a proper experience. The
amount of smoothness/clunkiness also directly

affects game play, as it tends to govern how
smooth/clunky the controls are (an added
incentive to buy a proper graphics card). Don’t

let that put you off though, as the game cer-
tainly holds its rewards.

This is one of those games that’s annoyingly

NNeevveerrbbaallll
Nail-biting world-tilting action with Neverball.

JOHN KNIGHT
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abundant in tense moments and can be down-
right frustrating, but the worst thing is it’s
incredibly addictive! You’ll find yourself almost

making it constantly, and the urge to have one
more go is always too strong and will keep you
playing. I found myself laughing like an idiot

every time I passed a level I’d been working at
a dozen times, and I’m sure you will too. And
for the pièce de résistance, you can save a
replay of the level you just finished and show
your mates!

With a large variety of novelty, and an 
environment that always stays fresh and origi-
nal with lots to toy with, Neverball is sure to
impress. If you’re the kind of person that really
gets off on nail-biting play, this is certainly 
the game for you, and with a Windows version
also available, you can give it to some 
un-enlightened windoze friends as well.�

John Knight is a 21-year-old, rock-
climbing, Japan-loving megalomani-
ac, trying to take over the world
from his bedroom via his keyboard.
He spends most of his time tinkering
with MPlayer and headbanging to his
MP3s.
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In the Clouds with Neverball

GAME INFO.

Neverball Site: http://www.icculus.org/neverball

Command: neverball

There’s a chance it already comes with 
your distro, so have a gander in your 
Games menu or try the command before 
you download the game.

http://www.icculus.org/neverball
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